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KOD 213GIM187

ALAN Matbaa

DAL/MESLEK Baskı Öncesi Operatörü
MODÜLÜN ADI Görüntü Tarama ve Düzeltme

MODÜLÜN TANIMI
Resimlerin taranması ve düzeltmelerinin yapılması ile ilgili
bilgi ve becerilerin kazandırıldığı öğrenme materyalidir.

SÜRE 40/32+32

ÖN KOŞUL Baskı öncesi dersini başarmış olmak

YETERLİK Tarama ve resmin düzenlenmesini yapmak

MODÜLÜN AMACI

Genel Amaç
Gerekli ortam sağlandığında, tekniğine uygun olarak tarama
yapabilecek ve resim işleme programında resimleri
düzeltebileceksiniz.
Amaçlar

1. Tekniğine uygun olarak tarama işlemini yapabileceksiniz.
2. Resim form ayarlarını tekniğine uygun olarak

yapabileceksiniz.
3. Tekniğine uygun olarak rötuş ayarlarını yapabileceksiniz.
4. Resmin renk ayarlarını tekniğine uygun olarak

yapabileceksiniz.

EĞİTİM ÖĞRETİM
ORTAMLARI VE
DONANIMLARI

Ortam: Masaüstü yayıncılık laboratuvarı, atölye, işletme vb.
Donanım: Bilgisayar, tarayıcı, yazıcı, görüntü işleme
programı

ÖLÇME VE
DEĞERLENDİRME

Bu modül içerisinde her öğrenme faaliyetinden sonra çoktan
seçmeli sorular ve uygulamalı sorularla kendi kendinizi
değerlendirebileceksiniz.
Modül sonunda öğretmeniniz tarafından yapılan uygulamalı
sınavla, kazandığınız bilgi ve beceriler değerlendirilecektir.

AÇIKLAMALAR
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GİRİŞ

Sevgili Öğrenci,

Teknolojinin gelişmesine paralel olarak insan hayatı kolaylaşmakta ve eskiden manuel
olarak yapılan iş ve işlemler günümüzde bilgisayarlarda veya bilgisayar destekli makinelerde
yapılmaktadır. Grafik tasarım alanı da bu teknolojik gelişmelerden nasibini almıştır.
Günümüzde farklı ortamlarda basılacak ya da yayımlanacak dergi, broşür, kitap, katalog vb.
materyaller dijital ortamda hazırlanmaktadır.

Masaüstü yayıncılıkta kullanılan programlar vektörel tabanlı programlar, dizgi ve
mizanpaj programları ile resim işleme programlarıdır. Vektörel tabanlı programlar; amblem-
logo, el ilanı, çizelge, broşür, afiş vb. işlerin tasarımında kullanılır. Dizgi ve izanpaj (sayfa
düzenleme) programları ise çok sayfalı (kitap, dergi, gazete vb.) materyallerin tasarımında
kullanılmaktadır. Resim işleme programları ise internet yayıncılığında, sunum hazırlamada,
kitap, dergi, afiş gibi basılı materyallerde kullanılacak görsellerin hazırlanmasında
kullanılmaktadır.

Resim işleme, yani resmi yayına hazır hâle getirme önemli bir iştir. Resimleri işleyip
düzenleyen, baskıya hazırlayanlar bu alanda uzman kişilerdir. Resim işleme fotoğraf
bilgisinin yanında program bilgisi, grafik bilgi ve becerisi isteyen bir daldır. Bu bilgi ve
becerilere sahip kalifiye elamanlara her zaman ihtiyaç vardır.

Bu modül resimlerin taranması ve görüntü işleme programında düzeltilmesi
işlemlerinin uygulamalı olarak anlatıldığı öğrenme materyalidir. Bu modülü öğretmeninizin
rehberliğinde bitirdiğinizde resimleri tarayabilecek ve resimleri düzenleyip baskıya veya
internet ortamına hazırlayabileceksiniz.

Tarama ve fotoğrafları düzeltme titiz ve dikkatli çalışmayı gerektirir. Öğrenme
sürecinde ne kadar titiz, dikkatli ve derse ilgili olursanız başarınız da o oranda artacaktır. Bu
modül ile daha nitelikli baskı öncesi operatörü olarak yetişeceğinize inanıyor ve başarılar
diliyorum.

GİRİŞ
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ÖĞRENME FAALİYETİ–1

Bu faaliyet ile gerekli ortam sağlandığında ideal çözünürlüğü seçerek tarama işlemini
tekniğine uygun olarak yapabileceksiniz.

 Çevrenizde bulunan baskı öncesi hazırlık hizmeti veren kuruluşlara ve

matbaalara giderek hangi tarayıcıları kullandıklarını, tarayıcıların özelliklerini

ve tarama işlemini nasıl yaptıklarını araştırınız.

 Topladığınız bilgileri arkadaşlarınızla paylaşınız.

1.TARAMA İŞLEMİ

Opak ya da saydam orijinalleri, tasarımlarda kullanılabilecek sayısal dosyalara
dönüştürme işlemine tarama denir. Tarama işlemi, tarayıcı (scanner) ile yapılır.

1.1. Tarayıcı

Tarayıcılar, basılı bir resmi, metni veya iki boyutlu herhangi bir basılı medyayı dijital
ortama yani bilgisayara sayısal olarak aktaran cihazlardır. Bir başka deyişle, fotoğraf veya
çizimlerin sayılaştırılmasında kullanılan, tamamen elektronik olarak çalışan cihazlardır.

Tarayıcıların kullanım amacına, hassasiyetine, profesyonellik düzeyine göre çeşitleri
vardır. Bunların en yaygın olanları Flatbed tarayıcılar ve Drum tarayıcılardır.

1.1.1. Flatped (Düz Yüzeyli) Tarayıcılar

Orijinal hareketsiz, okuyucu göz hareketli ve orijinalin yerleştiği yer düz bir satıh olan
yatay tarayıcılardır. Bu tarayıcılar belirli bir kalınlığa kadar orijinalleri yüksek çözünürlükte
tarayabilir. Transparan orijinalleri de tarayan çeşitleri mevcuttur. Bunlar ev ve ofis
kullanıcıları için tasarlanmış olan küçük, kullanımı kolay tarayıcılardır. Çoğu insanın tarayıcı
denilince aklına bu tip tarayıcılar gelir. Çünkü en yaygın olarak kullanılan tarayıcı çeşidi
budur. Ancak, son yıllarda profesyonel kullanım için üretilmiş olan düz yüzeyli tarayıcılar da
ülkemize girmiştir. Bunların bazı modellerinde üç boyutlu nesnelerin görüntülerini taramak
da mümkün hâle gelmiştir. Bunun anlamı fotoğraf makinesine gerek duyulmadan, tarayıcı
yüzeyine sığabilecek büyüklükteki nesnelerin görüntülerinin bilgisayar ekranına taşınabiliyor
olmasıdır.

ÖĞRENME FAALİYETİ–1

AMAÇ

ARAŞTIRMA
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Flatbed bir tarayıcı birçok bakımdan bir fotokopi makinesine benzer. Çizim veya
fotoğraf, tarayıcının kapağı altına yerleştirilir ve sayısal üretim süreci başlar. Flatbed
tarayıcılarda CCD teknolojisi kullanılır. CCD, tarayıcının kafasında yer alan ve taranan
nesneye binlerce ışın gönderen bir cihaz olan Charged Coupled Device’in kısaltmasıdır.
Kafa üzerindeki fotoelektrik hücreler, ışığın CCD’ye geri yansıyan kırmızı, yeşil ve mavi
(RGB) bileşenlerini algılar. Yansıtılan bu bilgiler görüntünün parlaklık ve koyuluğuna bağlı
olarak algılanır ve bilgisayara kaydedilebilecek biçimde sayısallaştırılır. Fladbed tarayıcılar
daha çok herhangi bir opak orijinali (ışık geçirgenliği olmayan) bilgisayar ortamına
aktarmakta kullandığımız çözünürlük seviyesi, tamburlu ve saydam tarayıcılara göre düşük
olan masaüstü tarayıcılardır. Bu tarayıcılar her ne kadar baskı öncesi hazırlıkta kullanılsa da
tamburlu tarayıcılarkadar kaliteli sonuçlar vermez.

Resim 1.1: Flatped tarayıcı

1.1.2. Drum (Tamburlu) Tarayıcılar

Bunlar, profesyonel amaçlar için tasarlanmış tarayıcılardır. Taranacak medya, gerek
saydam (diapozitif), gerekse kâğıt (opak) olsun, boyutuna göre özel bir silindirin üzerine
yapıştırılarak (Drum tabiri buradan geliyor.) döndürülürken lazer göz vasıtasıyla okunur.

Bu tarayıcılarda orijinal hareketli, okuyucu göz sabittir. Orijinal silindire sabitleştirilir
ve silindir 600-1600 devir arasında dönmeye başlar. Bu tip tarayıcılarla diapozitif, fazla kalın
olmayan opak ve diğer transparan orijinaller kaliteli bir şekilde taranır. Tamburlu tarayıcılar
ışığı algılamak için CCD yerine genellikle PMT olarak adlandırılan bir foto çoğaltıcı tüp
kullanır. PMT teknolojisinde taranan görüntü bir tambur etrafında dönerken sabit bir kaynak,
ışığı, foto çoğaltıcı tüpler kullanarak aktarır. Dönen tamburun gelişmiş foto algılayıcıları ve
ileri seviye optik donanımı, tamburlu tarayıcıyı parlak ve koyu bölgelere karşı çoğu CCD
tarayıcıdan çok daha duyarlı kılar.

Taranacak orijinal dia ise küçük silindire, opak ise büyük silindire takılıp orjinalin
ebadı ve istenilen ölçüsü makineye tanıtılır. Orijinalin renk ve ton durumu göz önünde
bulundurularak en açık yerinden beyaz ve en koyu yerinden de siyah makineye bildirilir.
Makine böylelikle ara tonları ve renkleri kendisi otomatik olarak ayarlar.
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Bu tip tarayıcılar çok gelişmiş olup masaüstü yayıncılık sistemlerinde ve baskı
sistemlerinde kullanılır. Genelde gazetelerin, dergilerin, broşürlerin resimlerinin
hazırlanmasında yaygın biçimde kullanılır. Hassas, hatasız, kaliteli sonuçlar alabilmek ve en
önemlisi resmi orijinal boyutundan çok daha fazla büyütebilmek için kullanılır.

1.2. Orijinal

Üzerinde çalışılacak olan bir resmin ilk hâlidir. Tarayıcıda taranarak film çıkışa
hazırlanan ya da reprodüksiyon atölyesinde filmi çekilen tire veya yarım ton resme orijinal
denir. Orijinallerin çeşitleri vardır. Bunlar; opak, transparan ve dijital orijinallerdir.

1.2.1. Opak Orijinaller

Işığı geçirmeyip yansıtan, saydam olmayan orijinallerdir. Karta basılmış fotoğraflar,
dergi veya kitap sayfaları, afişler gibi ışığı geçirmeyen materyaller opak orijinallere örnektir.
Kullanılacak opak orijinallerinin yüzeyinin düzgün olması gerekir. Opak orijinalin 3.hamur
kâğıt gibi grenli bir yüzeyi varsa, tarama yapıldıktan sonra kâğıdın dokusu da bilgisayarda
görüntülenecek ve tarama kalitesini düşürecektir. Mümkün olduğunca düzgün yüzeyli
kâğıtlara basılmış (fotoğraf kâğıtları, kuşe kâğıtlar) orijinaller kullanılmalıdır.

1.2.2. Transparan Orijinaller

Işığı geçiren, saydam orijinallerdir. Diapozitifler ve negatifler transparan orijinallere
örnektir. Transparan orijinaller flatped (bu özelliği olan tarayıcılarda) ve tamburlu
tarayıcılarda taranabilir. Aynı zamanda sadece transparan orijinalleri tarayan saydam
tarayıcılar vardır.

1.2.3. Dijital Orijinaller

Bilgisayarda bulunan tüm görüntülerdir. Bu orijinaller; dijital fotoğraf makinesinde
çekilip bilgisayara aktarılmış olan bir resim, internetten indirilmiş resim, piksel veya vektörel
esaslı görüntüler vb. olabilir. Kısaca bilgisayar ekranındaki bütün görüntüler dijital orijinale
örnek olarak verilebilir.

1.3. Tarama Ayarları

Tarayıcıların çalışma prensibi hemen hemen aynıdır. Resim işleme programında
tarama yapmak için orijinal tarayıcıya yerleştirilir ve File/Import/(Tarayıcı Adı) komutu
kullanılır. Bu komuttan sonra tarayıcı otomatik olarak ön tarama yapar. Tarayıcıların
markalarına veya yazılımlarına göre değişiklik gösterse de mantık hep aynıdır. Modele göre
bu işlem prEscan veya preview olarak adlandırılabilir. Önce bu işlem gerçekleştirilir. Ön
tarama işleminin amacı yeterli bir ekran görüntüsü elde edip gerçekten taranacak bölgenin
belirlenerek işaretlenebilmesi içindir.

Ön taramadan sonra tarama alanı, tarama modu, tram kırımı, çözünürlük gibi
ayarlamalara geçilir.
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1.3.1. Tarama Alanı

Ön tarama ile ekrana gelen görüntüden işimize yarayacak bölümün işaretlenmesi
gerekir. İşaretlenmediği takdirde tarayıcı resmin tamamını tarayacaktır. Bunu tarayıcının
markasına ve yazılımının kalitesine göre çeşitli şekillerde yapmak mümkün olabilir.
Dörtgen, dairesel, poligon şeklinde ve serbest el seçimi şeklinde seçim yapmak mümkündür.

1.3.2. Tarama Modu

Taramada kullanılacak renk modudur. Orijinal RGB, CMYK, Grayscale veya Black
White (tire) gibi modlarda taranabilir.

Yazı veya basit logo gibi tire bir görüntü tarama amacındaysanız; B/W Document
veya B/W Lineart seçeneği ile taramak gerekir. Çünkü harf ve logo kenarlarının keskin hatlı
olması gereklidir.

Yarım ton ve tek renkli bir orijinal taramak için B/W halftone veya Grayscale modu
seçilir. Renkli bir fotoğraf taramak için RGB veya CMYK renk modu kullanılır.

Resim 1.2: Tarama programı penceresi

1.3.3. Tram Kırımı (DEscreen)

Yarım ton bir görüntü tarandığında bu görüntüyü oluşturan tram noktaları ekranda
belirgin olabilir. Bu duruma genelde yüzeyi düzgün ve parlak olmayan 1. ve 3. hamur
kâğıtlar üzerindeki görüntüler tarandığında karşılaşılır. Tram noktalarını yok etmek için
yapılan işleme DEscreen denir. Filter/Despeckle, Fitler/Blur gibi komutlarla bu sorun
çözülebilir.
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Resim 1.3: Tram noktaları belirgin olan resim Resim 1.4: DEscreen yapılmış resim

1.3.4. Çözünürlük (Rezülasyon)

Çözünürlük sözlük anlamı ile belirli bir alan içindeki öge sayısı olarak açıklanabilir.
Matbaacılıkta ise çözünürlük birim içerisindeki nokta sayısıdır. Diğer bir deyişle uzunluk
biriminde birbirinden ayırt edilebilen nokta sayısıdır.

Çözünürlük hesaplarında uzunluk birimi olarak inç veya santimetre kullanılır. Bir inç
= 25.4 mm veya 2.54 cm’dir. Basit hesaplarda 2.5 cm değerini kullanabiliriz. Gündelik
yaşamda ülkemizde batılı ülkelerin aksine cm kullanıldığından birçok işlemi cm üzerinden
yapmak daha kolaydır.

PPC, PPI: Pixel Per Cm / Inch: Kullanabileceğiniz en iyi birimdir. Genellikle DPI
(Dot Per Inch) ile karıştırılır. İkisinin farklı birimler olduğu unutulmamalıdır. Piksels /
centimeter inç, bir santimetreye / inç'e düşen piksel sayısıdır. Bu, görüntünün öz nitelikleri
ile ilgili bir kavramdır. Diğer ölçümler gibi, yazıcı veya tarayıcılar ile doğrudan ilgili
değildir.

Masaüstü yayıncılıkta temel olarak üç çeşit çözünürlük birimi vardır. Bu üç çözünür-
lük birimi dijital görüntü işlemede önemli rol oynar.

1.3.4.1. Tram Sıklığı

Bir hat üzerindeki tram nokta sayısıdır. Birimi LPCM ya da LPI'dır. Burada çizgi ile
anlatılmak istenen tramdır. Bu tram nokta, çizgi ya da herhangi bir tram nokta çeşidi de
olabilir. Burada kullanılan ölçüm biriminin inç olmasının sebebi ise bilgisayar ortamında
ölçülendirmenin inç üzerinden yapılmasındandır. Bilgisayarın ve sistemi geliştiren
ülkelerdeki ölçü sistemi Türkiye'deki gibi metrik sistem değildir ve inç ölçü birimini
kullanmaktadırlar. Aşağıda ülkemizdeki tram sıklığı birimleri ve bilgisayardaki karşılıkları
görülmektedir.
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28 lpinch = 70 lpcm
33 lpinch = 84 lpcm
40 lpinch = 100 lpcm
48 lpinch = 120 lpcm
54 lpinch = 133 lpcm
60 lpinch = 150 lpcm
70 lpinch = 175 lpcm
80 lpinch = 200 lpcm

X lpcm x 2,5= inç karşılığını yani bilgisayardaki karşılığını verir.

Tablo 1.1: Kullanılan tram sıklıklarının metrik ve inç sistemine göre dönüşümleri

Bilgisayardaki görüntünün basılabilmesi için tram noktacıklarına çevrilmesi gerekir.
Bilgisayardan çıkış alınmak istendiğinde tram sıklığı yani LPİ belirtilir. Bu belirtilen tram
sıklığına göre yatayda ve dikeyde ikişer piksel bir araya gelerek bir tram noktasının
taşıyacağı yüzde (%) değerini kısaca nokta yoğunluğunu belirler.

1.3.4.2. Piksel Sıklığı (Ekran Çözünürlüğü)

Dijital ortamda bir görüntü piksel adı verilen küçük noktacıklar ile oluşturulur. Piksel
kare şeklinde olan görüntünün en küçük birimidir. Dijital görüntüler yana yana gelen
pikseller topluluğundan oluşmaktadır. Dijital görüntü, imgenin eninde ve boyunda bulunan
piksel sayısı ile tanımlanır. Pikselin kendi başına en ve boy değerleri yoktur.

Kendi başlarına boyut sahibi olmayan piksellere çoğu zaman bir boyut değeri
tanımlamak gereklidir. Bu şekilde piksellerin boyutu belirlendiğinde uzunluk biriminde kaç
piksel bulunacağı da belirlenmiş olur. Örneğin bir pikselin boyutu 1 mm olarak
tanımlanmışsa her santimetrede 10 piksel bulunacaktır.

PPI/PPC birimleri genellikle görüntünün bilgisayar ortamındaki çözünürlüğünü
vermek için kullanılır ve inç/cm başına düşen piksel sayısı anlamındadır. Eğer bir
görüntünün çözünürlüğü 300 PPI deniyorsa bu görüntünün bir inç’inde 300 piksel var

demektir ve görüntünün tamamındaki piksel sayısı da boyutlarına göre hesaplanabilir. 10
cm uzunluğunda ve 20 cm enindeki bir görüntü, 100 PPC çözünürlüğe sahip ise, boyunda
10cm*100PPC=1000 piksel, eninde ise 20cm*100PPC= 2000 piksel vardır. Görüntüdeki
toplam piksel sayısı en*boy =2000piksel*1000piksel = 2.000.000 piksel'dir.

1.3.4.3. Nokta Sıklığı (Baskı Çözünürlüğü)

Görüntüden çıkış alındığında görüntüyü oluşturmak için kullanılan noktanın
çözünürlük birimini DPİ ile ifade edilir ve inç başına düşen nokta sayısı anlamındadır.

DPİile PPI aynı çözünürlüğü ifade edebilir. Ancak tarayıcı ve bilgisayardaki
çözünürlük ile çıkış çözünürlüğünü kavramsal olarak ayırmak için kullanılır. Matbaada
basılacak bir görüntünün en az 300 DPİ olması gerekmektedir.



9

1.3.4.4. Tarama Çözünürlüğü

Resmin bilgisayara aktarılması çok önemli bir işlemdir. Görüntünün taşıyacağı
özellikler bu aşamada belirlenir. Sonucun kaliteli olması için işlemin doğru yapılması
gerekmektedir. Tarama çözünürlüğü verilirken büyütme ve küçültme oranları da göz önüne
alınır.

Teknik açıdan baskı filmi hazırlamada ilk aşama scanning-tarama işlemi ile başlar.
Burada dikkat edilecek ilk nokta tarama çözünürlüğüdür (rezülasyon). Çünkü en çok hatanın
yapılabileceği nokta burasıdır. Çözünürlüğü belirlemede yapılan araştırmaların sonucu şu
değerleri ortaya koymuştur.

Tarama Çözünürlüğünün Hesaplanması

Kalite faktörünün tram sıklığı (LPİ) ile çarpımı tarama çözünürlüğünü verir. Kalite
faktörü kat sayısı genellikle 2 alınmakla beraber tram sıklığı 133 LPİ’den düşük olduğu
zaman yine 2, büyük olduğu zaman 1,5 alınabilir.

Tarama Çöz. = Tram Sıklığı x Kalite Faktörü x Boy Küçültme Oranı
Tarama Çözünürlüğü = 150 LPİ x 1.5 x 2 = 450 PPI
Tarama Çözünürlüğü = 100 LPİ x 2 x 0.75 = 150 PPI

Büyültme-küçültme oranı = İstenilen boyut / Orijinal boyut
B.K. Oranı = 150 cm / 75 cm = 2 = % 200
B.K. Oranı = 15 cm / 20 cm = 0.75 = % 75

Örnek: 10x15cm2 ebadındaki opak orijinal taranarak 20x30cm2 ebadında 150 LPİ’de
basılacaktır. Buna göre tarama çözünürlüğü kaç olmalıdır?

Çözüm: 150LPİ x 1,5 x 4=900 PPİ

Çözünürlüğün çok yüksek olması, görüntünün de çok kaliteli olacağı anlamına
gelmez. Doğru çözünürlük değerini yukarıdaki formüller doğrultusunda bulmak gerekir.
Yüksek çözünürlük demek yüksek dosya büyüklüğü demektir. Bu da işlem esnasında uzun
zaman alacaktır. Düşük dosya çözünürlüğünün veya ebadının sonradan artırılması görüntüde
netlik ve detay kaybına neden olacaktır. Renk ve tonlarda da bozulmalar ortaya çıkacaktır.

Bu anlatılan sebeplerden dolayı çözünürlük iyi hesap edilerek verilmeli, bunların
dışındaki değerlerin kalitede kayıp demek olduğu ve oldukça zaman alacağı
unutulmamalıdır.

1.4. Kayıt İşlemi

Çalışılan bir dosyayı tekrar kullanabilmek için kaydetmek gerekir. Kaydedilmediğinde
yapılan işler boşa gitmiş olur. Bundan dolayı kayıt işlemi önemlidir. Resim işleme
programında çalışılan bir dosyayı kaydetmek için File>Save komutu verilir. Bu komut
verildiğinde dosya ilk defa kaydediliyorsa ekrana Save as iletişim kutusu açılır. Bu iletişim
kutusunda konum bölümüne resmin nereye kaydedileceği, dosyanın ismi ve formatı girilerek
kayıt işlemi yapılır.
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Resim 1.5: Kayıt iletişim kutusu

Dosya, programın kendi formatında (PSD) kaydedilebileceği gibi, resim diğer
programlarda kullanılmak için farklı formatlarda da kaydedilebilir. Format seçimi dosyanın
hangi amaçla kullanılacağına göre yapılır. Örneğin dosya baskıda kullanılacaksa, EPS, PDF
veya TIFF formatında kaydedilir.

1.4.1. Görüntü Formatları

Masaüstü yayıncılıkta programlar birbirlerinden dosya alışverişinde bulunarak çalışır.
Bir resmi veya vektörel çizimi oluşturduğumuz uygulama programından bağımsız hâle
getirip sayfa düzenleme programına ya da vektörel programlara aktarmak için farklı bir
formatta kaydetmemiz gerekir.

Masaüstü yayıncılıkta yaygın kullanılan görüntü formatları aşağıda verilmiştir.

1.4.1.1. EPS

EPS formatı hemen hemen bütün çizim ve sayfa düzenleme programları tarafından
desteklenir. Photoshop programında, doküman Bitmap modunda kaydedilirken Transparan
Whites (Beyazları transparan yap) seçeneği işaretlenerek kaydedilirse, dosyada beyaz
alanları şeffaf olarak tanımlanır. Renkli bir doküman EPS olarak kaydedilecekse, olası baskı
problemlerini önlemek için CMYK moduna geçirilmiş olmalıdır.
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Kaydederken karşınıza çıkan diyalog kutusunda;

Preview: EPS dosyanızı diğer programlarda kullanırken resmin nasıl göründüğüne
dair bir ön görüntüdür. Bu sayede resmi istediğiniz kadraja yerleştirebilirsiniz. Bu menüdeki
Macintosh seçeneği bütün programların kullanabileceği bir PICT ön görüntü oluşturur.
Dosyanızın ön görüntüsünü TIFF seçerseniz bu dosyayı IBM uyumlu bilgisayarlarda da
kullanabilirsiniz.

Encoding: Bilgilerin dosya içinde ASCII ya da Binary şeklinde saklanmasını
isteyebilirsiniz. Binary kodlama ASCII’nin yarısı kadar yer tutar. Genellikle Binary
kullanılır; fakat bazı PostScript hatalarını resim dosyalarını ASCII kaydederek önlemeyi
deneyebilirsiniz.

Clipping Paths: Photoshop 4,0 versiyonunda görüntü dosyanız üzerinde dekupe
etmek istediğiniz bölgeyi kapsayan path’i seçeceğiniz bölümdür. Photoshop 5,5 versiyonu,
eğer kaydet komutunuzdan önce path penceresinden çizimi clipping etmişseniz, otomatik
olarak dekupe edilmiş görüntüyü dosya içine yazar.

1.4.1.2. DCS1

CMYK olarak kaydedilmiş EPS dosyalar için geçerlidir. DCS yüksek çözümlemeli
renk bilgisini içeren 4 adet (C,M,Y,K) dosya ve beşinci olarak sayfa düzenlemede
kullanacağınız bir ana dosya oluşturur. Ana dosya 72 DPİ bir öngörüntü dosyasıdır, 4 adet
yüksek çözümlemeli dosya baskı sırasında kullanılır. Dikkat etmemiz gereken bir nokta,
DCS’nin yarattığı sayfa düzenlemede kullanacağınız ön görüntü dosyasının ismini asla
değiştirmeyiniz. Eğer değiştirirseniz dosyanız baskı sırasında yüksek çözümleme dosyaları
bulamayacağından ön görüntü dosyasını (72 DPİ) basar.
Kaydetme sırasındaki seçeneklerinizin ilki, ön görüntünün nasıl olacağı, ikincisi dosya
biçimi, üçüncüsü ise yüksek çözümleme dosyalarının sıkıştırma biçimi ile ilgilidir.

1.4.1.3. DCS2

CMYK+Ekstra renkler için kullanılan dosya kayıt biçimidir. Resim üzerinde ekstra
(Beta) kanal kullandığınızda dosyanız içindeki beşinci veya daha fazla renk kanallarını
bastırmak için kullanacağınız format biçimidir.

EPS ayrıca vektörel programların (Ilustrator ve FreeHand) sayfa düzenleme
programlarına dosya aktarım formatıdır. Vektörel dosyalar EPS formatında kaydedilmez ise
sayfa düzenleme ve resim programları kendi dosya içlerine alamaz. Örneğin Photoshop
programı vektörel çizimli bir EPS dosyasını restarize ederek (piksele çevirerek) kendi
bünyesine alabilir. QuarkXpress programı EPS formatlı dosyaları bir ön görüntü (Preview)
dosyası oluşturarak sayfa üzerine yapıştırır.
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1.4.1.4.TIFF

TIFF formatı bilgisayarlar arası ortak bir dosya formatıdır. Tüm programlar tarafından
desteklenir. Bu formatta kayıtlı dosyalar, herhangi bir uygulama programının sayfa içine
alındığında görüntü ve zeminin renk değerlerini azaltma ve değiştirme olanağı verir. Örneğin
farklı farklı renklerde kullanacağımız bir görüntü ya da logoyu TIFF formatla kaydedip
sayfaya yapıştırdığımızda renklerini değiştirebiliriz. Bu yolla her renk değişikliğinde onu
yaratan uygulama programını açıp yeniden renk verip yeni dosyalar yaratmamış oluruz.

Kayıt sırasında LWZ seçeneği dosyayı sıkıştırarak kaydedilmesini sağlar; ancak bu
seçenekle kayıtlı dosyaları film baskı araçları desteklemez. Bu kayıt biçimiyle gönderilen
dosyalar, film servisine bildirilirse, doğacak sorunlar baştan çözülmüş olur.

1.4.1.5. JPG

JPG formatının en büyük özelliği görüntüyü sıkıştırabilmesidir (dosya hacmini
küçültmek). Bir nevi arşivleme formatıdır. JPEG veya JPG formatının bir diğer özelliği
gerçek renk değerlerini içermesidir. Bu nedenle fotoğrafik (çizgisel/grafiksel olmayan)
görüntüler için kullanılmalıdır.

JPEG sıkıştırma yöntemi görüntünün algılanması için zorunlu olmayan detayları bulup
atan ve dosyayı bu şekilde sıkıştıran bir format olduğundan kayıplı formatlar arasında yer
alır. Kaybolan ayrıntılar ve sıkıştırma oranı arasında bağlantı bulunduğundan bu dengeyi iyi
korumak gerekmektedir. Daha fazla sıkıştırma daha fazla detay kaybı daha az sıkıştırma
daha büyük dosya demektir. Kaybedilen detayların geri getirilmesi söz konusu olmadığından
dosyanın bir kopyası mutlaka alınmalıdır.

1.4.1.6. BMP

BMP Windows ve Microsoft’un PCX formatını değiştirerek geliştirdiği bir formattır.
Windows 3.1 ve 95 ile birlikte gelen Paint programı görüntüleri bu formatta işler. BMP
formatı 1-24 bit arasında değişen bir piksel derinliğini içerebilir. Sıkıştırma seçeneği
başlangıçta bulunmamakta idi. Opsiyon olan bu sıkıştırma, görüntüde detay kaybına yol
açmaz, yani kayıpsız sıkıştırma yöntemlerindendir. BMP formatı alıcı bilgisayarında
Paint’den başka görüntü programı bulunmadığı durumlarda kullanılır.

1.4.1.7 GIF

Graphics Interchange Format (GIF) dosyaları internet üzerinde oldukça yaygın
kullanılan bir formattır. Az sayıda renk içeren (1 ila 8 bitlik) dokümanlarda oldukça iyi
sıkıştırma sağlaması, animasyonlarda zamanlama ve farklı boyutlardaki resimleri bir arada
tutma desteği, saydam renk tanımlanması bu formatı popüler yapan nedenlerden sadece
birkaçıdır.
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Ancak resim işleme programlarının çoğu GIF formatının tüm özelliklerini
kullanamamaktadır. Bu nedenle bu format ile çalışırken sıklıkla başka programlara
gereksinim duyulmaktadır. GIF dosyaları Bitmap, gri skala ve indekslenmiş renk sisteminde
olabilmektedir. Gerçek renk desteği yoktur. GIF resimleri sıralı (interlaced) veya sırasız
kaydedilebilmektedir. Sıralı GIF dosyaları yükleme esnasında satır satır gelerek resim
bitiminden önce neye benzeyeceğine dair bir ipucu verir. Saydamlık tanımlanması için
GIF89a Export komutu kullanılarak saydam olacak renk belirlenebilir.

1.4.1.8. PNG

PNG Portable Network Graphics formatı patentsizdir. PNG kayıpsız Wave Table
sıkıştırma yöntemini kullanır. Şu anda mevcut olmayan kayıpsız gerçek renk ve saydamlık
bilgilerini içeren resim kalitesini internete taşımayı amaçlamaktadır. PNG dosyalarındaki
saydamlık bilgileri alfa kanalı içerisinde saklanmaktadır. Sıralı yükleme de olanaklıdır.
Ayrıca sıkıştırma için değişik filtreleme algoritmaları sıkıştırma öncesi kullanılabilmektedir.

1.4.1.9. PSD

Photoshop Document (PSD) Photoshop uygulamasına özel bir formattır. PSD çok
sayıda alfa kanalını, pathı ve katmanı desteklemektedir. PSD dosyaları ikili dosya,
indekslenmiş renk, gerçek renk RGB, CMYK, Lab biçimlerini destekler. Çalışma yaptığınız
işlerin PSD’sini saklamayı alışkanlık hâline getirmeniz, daha sonra yapılacak düzeltmelerde
çok işinize yarayacaktır.

1.4.1.10. PICT

PICT formatı bütün programların ortak kullandığı dosya formatıdır. Herhangi bir
uygulama programına aktarıldığında resim bilgisi sayfaya dâhil olur. Görüntü diskinizden
silinse dahi baskı aracı sayfayı basarken PICT dosyasını aramaz. Logo düzenleme ve
yeniden oluşturma işlemleri sırasında PICT olarak kaydedilmiş görüntüyü, vektörel
programlara aktardığımızda, Ilustrator programı isteğe bağlı olarak dosya aç komutuyla
görüntüyü açar ve sayfaya Template (yarı saydam/arka plan) olarak yapıştırır. Böylelikle bu
görüntünün üzerinden vektörel olarak çizimimizi yapabiliriz. FreeHand programı ise resim
al komutuyla sayfa içine resim olarak aktarır, görüntüyü Template (yarı saydam/arka plan)
yapmak için Layer paletinden background (arka plan)’ı seçerek vektörel olarak çizebiliriz.
PICT ile sayfa üzerine yapıştırdığınız görüntüyü ancak sunum için kullanabilirsiniz.

Masaüstü lazer yazıcılarda görüntü pürüzsüz çıkabilir ama baskı ortamına
aktardığınızda görüntü kırıklaşıp flu bir hâl alır. Sunum işiniz bittiğinde görüntüyü yeniden
yüksek (HiRes) taratıp (300 DPİ) sayfa üzerine yerleştirmeniz gerekir.
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UYGULAMA FAALİYETİ

İşlem Basamakları Öneriler

 Tarayacağınız orijinali, tarayıcıya
düzgünce yerleştiriniz.

 Tarayıcının ve orijinalin temiz
olmasına dikkat ediniz. Toz ve
pisliklerden arındırınız.

 Metal ve kesici eşyaları
tarayıcının camından uzak
tutunuz.

 Tarayacağınız orijinal dia ise
orijinali dia bölmesine
yerleştirmelisiniz.

 Resim işleme programında
File>Import> (Tarayıcı ismi) komutuyla
tarayıcı iletişim penceresini açınız.

 Tarayıcı kablosunun bilgisayara
takılı olmasına dikkat ediniz.

 Bu komut verildiğinde tarayıcı
otomatik olarak ön tarama
yapacaktır. Yapmadıysa PrEscan
tuşuna tıklayarak ön tarama
yaptırınız.

 Tarayacağınız orijinalin türünü
belirleyiniz.

 Bu seçenek tarayıcının modeline
göre değişir. Genelde opak
orijinaller flatped olarak
isimlendirilir.

 Tarayacağınız alanı seçiniz.
 Tarayacağınız alan seçilmezse

tarayıcı tüm yüzeyi tarayacaktır.

 Image Type bölümünden tarayacağınız
görüntünün modunu seçiniz.

 Yazı, çizelge gibi tire orijinal
tarıyorsanız, B&W Linear
seçeneğini işaretlemelisiniz.

UYGULAMA FAALİYETİ
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 Rezülasyon (çözünürlük) bölümüne
tarama çözünürlüğünü yazınız.

 Tarama çözünürlüğünü doğru
hesaplamaya dikkat ediniz.
Çünkü görüntünün kalitesine
etki eden en önemli özellik
çözünürlüktür.

 Scale (boyut) bölümüne orijinali kaç kat
büyütüp veya küçülteceğinizi yazınız.

 Girdiğiniz değerleri tekrar
kontrol ediniz.

 Girdiğiniz değerlerin doğruluğundan
eminseniz, Scan düğmesini tıklayarak
tarama işlemini tamamlayınız.

 Taramadan sonra resim otomatik
olarak resim işleme programında
açılacaktır. Taranan resmi
dikkatli bir şekilde inceleyiniz.

 Taradığınız resmi File/Save komutuyla
kaydediniz.

 Ctrl+S (Command+S)
kısayoluyla kaydedebilirsiniz.

 Kaydederken format seçimini
bilinçli yapınız. Gif, Jpeg gibi
formatlarda görüntü kaybının
olacağını unutmayınız.
Basılacak bir resimde
çalışıyorsanız TIFF formatını
tercih ediniz. Resim üzerinde
kayıt işleminden sonra değişiklik
yapacaksanız PSD formatını
tercih ediniz.
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ÖLÇME VE DEĞERLENDİRME

A. OBJEKTİF TESTLER

Çoktan Seçmeli Test

Aşağıdaki sorularda doğru olan şıkkı işaretleyiniz.

1. Aşağıdakilerden hangisi Drum (tamburlu) tarayıcıların özelliklerinden değildir?

A) Orijinal hareketli okuyucu göz sabittir.
B) Opak ve dia orijinalleri tarayabilir.
C) Tarama kalitesi Flatped tarayıcılardan düşüktür.
D) Profesyonel amaçlar için kullanılır.

2. Aşağıdakilerden hangisi diğerlerine göre farklı bir orijinaldir?

A) Fotoğraf kâğıdı
B) Diapozitif
C) Kuşe kâğıt
D) Karton

3. Bilgisayar ortamındaki bir görüntünün basılabilmesi için ……….. noktacıklarına
çevrilmesi gerekir.
Yukarıdaki boşluğa aşağıdakilerden hangisi gelmelidir?

A) Piksel
B) Bitmap
C) Tram
D) Gren

4. Aşağıdakilerden hangisi orijinal türlerinden değildir?

A) Dijital orijinal
B) Opak orijinal
C) Transparan orijinal
D) Üç boyutlu orijinal

5. 75’lik tram kaç LPİ eder?

A) 190
B) 175
C) 220
D) 150

ÖLÇME VE DEĞERLENDİRME
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6. Basılacak renkli bir görüntü kaydedilirken aşağıdaki formatlardan hangisi tercih
edilmemelidir?

A) TİFF
B) GİF
C) EPS
D) PSD

7. 25x35cm ebadındaki opak orijinal taranarak 35x50cm ebadında 175 LPİ’de
basılacaktır. Buna göre tarama çözünürlüğü kaç olmalıdır?

A) 725 PPİ
B) 625 PPİ
C) 525 PPİ
D) 300 PPİ

8. Birim (inç) başına düşen nokta sayısına ne ad verilir?

A) Tram
B) Çözünürlük
C) Görüntü kalitesi
D) DEscreen

9. Aşağıdakilerden hangisi tarayıcıda taranamaz?

A) İki boyutlu görüntü
B) Kitap kapağı
C) Gazete
D) Üç boyutlu görüntü

10. 10x15cm2 ebadındaki görüntü 20x30cm2 ebadında kuşe kâğıda 80’ lik tramla
basılacaktır. Buna göre tarama çözünürlüğü kaç olmalıdır?

A) 1500 PPİ
B) 1400 PPİ
C) 1300 PPİ
D) 1200 PPİ

DEĞERLENDİRME

Cevaplarınızı modül sonundaki cevap anahtarı ile karşılaştırınız ve doğru cevap
sayınızı belirleyerek kendinizi değerlendiriniz.

Ölçme sorularındaki yanlış cevaplarınızı tekrar ederek, araştırarak ya da
öğretmeninizden yardım alarak tamamlayınız.
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B. UYGULAMALI TEST

Öğrenme faaliyetinde kazandığınız becerileri aşağıdaki kontrol listesine göre
değerlendiriniz.

DEĞERLENDİRME ÖLÇÜTLERİ Evet Hayır

1. Resmi tarayıcıya yerleştirdiniz mi?

2. Tarayıcı iletişim penceresini açtınız mı?

3. Tarayacağınız orijinalin türünü bilgisayara girdiniz
mi?

4. Tarayacağınız alanı seçtiniz mi?

5. Tarama modunu belirlediniz mi?

6. Tarama çözünürlüğünü hesapladınız mı?

7. Orijinalin büyültme küçültme ayarını yaptınız mı?

8. Tarama işlemini tamamladınız mı?

9. Taranan resmi TIFF formatında kaydettiniz mi?

DEĞERLENDİRME

Faaliyet değerlendirmeniz sonucunda “Hayır”ı işaretleyerek yapamadığınız işlemleri
tekrar ediniz.

Tüm işlemleri başarıyla tamamladıysanız bir sonraki faaliyete geçiniz.
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ÖĞRENME FAALİYETİ–2

Bu faaliyet ile gerekli ortam sağlandığında resim işleme programını tanıyacak ve
resim form ayarlarını tekniğine uygun olarak yapabileceksiniz.

 Çevrenizde bulunan film servis bürolarına ve matbaalara giderek buradaki

grafikerlerin resim form ayarlarını nasıl yaptıklarını ve resim işleme

programlarını araştırınız.

 Bu konuyla ilgili web sitelerini ziyaret ediniz.

 Topladığınız bilgileri arkadaşlarınızla paylaşınız.

2. RESİM FORM AYARI

2.1. Resim İşleme Programları

Masaüstü yayıncılıkta kullanılan programları üç grupta toplayabiliriz. Bunlar; sayfa
mizanpaj programları, vektörel tabanlı grafik tasarım programları ve resim işleme
programlarıdır. Bu programların kullanım amaçları farklıdır. Örneğin bir sayfa mizanpaj
programıyla fotoğrafa rötuş yapamaz veya fotoğrafın renk ayarlarıyla oynayamazsınız.
Böyle bir işte resim işleme programına gereksinim vardır.

2.1.1. Tanımı ve Özellikleri

Resim işleme programları, bitmap tabanlıdır. Yani bu programlarda ölçü birimi
pikseldir. Bir başka deyişle bu programlar, vektörel programlarda olduğu gibi matematiksel
formüllerle değil, piksellerle çalışır.

Resim işleme programları; fotoğraflar ve görüntüler üzerinde rötuş ve değişikliklerin
yapıldığı veya sıfırdan başlayarak orijinal resimsel eserlerin üretildiği programlardır. Resim
işleme programıyla, siyah beyaz bir fotoğrafı renklendirme, görüntünün üzerinde oynama,
fotoğrafın boyutunu değiştirme, resme değişik efektler verme, fotoğraf montajı yapma vb.
işlemleri gerçekleştirebilirsiniz.

Resim işleme programlarının geniş bir kullanım yelpazesi vardır. Bu programları
grafikerler baskıya yönelik afiş, broşür, katalog, kitap, dergi ve gazetelerin resim çalışmaları
vb. işlerde kullanmaktadır. Web tasarımcıları web sayfalarına resim ve görüntü hazırlamak
için bu programları kullanır.

ÖĞRENME FAALİYETİ–2

AMAÇ

ARAŞTIRMA
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Fotoğrafçılar fotoğraflara rötuş yapmak ve düzenlemek için resim işleme programı
kullanır. Aynı zamanda amatör resim çalışmaları için yine bu programlar kullanılmaktadır.

Masaüstü yayıncılıkta farklı resim işleme programları kullanılmaktadır. Bu
programların en yaygın olanı Photoshop programıdır.

2.1.2. Piksel

Dijital ortamda görüntünün en küçük birimine piksel denir. Monitör üzerinde görüntü
piksellerin yan yana gelmesiyle oluşur. Piksellerin kendi başına en ve boy değerleri yoktur.
Her piksel kare biçimindedir ve her pikselde sadece 1 renk vardır. Bir pikselin bir kısmı açık
bir kısmı koyu ya da yeşil, koyu yeşil olmaz. Bu tür renk geçişleri (degrade) farklı renkte
piksellerin yan yana gelmesinden oluşur. Resminizin görüntüsünü 10-15 kat büyüttüğünüzde
resmi oluşturan pikselleri görebilirsiniz (Şekil 2.1 ve 2.2).

Resim 2.1 Resim 2.2: Piksellerin görüntüsü

2.1.3. Genel Menüler

Bir resim işleme programı genel olarak araç kutusu, paletler ve menülerden oluşur.

Resim 2.3: Resim işleme programı çalışma ortamı
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2.1.3.1. Araç Kutusu

Araç kutusunu, bir çalışma masası veya boya kutusuna benzetebiliriz. Boyamak,
silmek veya görüntü üzerinde yapmak istenilen tüm işlemler için ihtiyaç duyulan araçları
içerir. Araçların sağ alt köşelerindeki oklar, o aracın altında benzer birkaç tane daha araç
olduğuna işarettir.

Resim 2.4: Araç kutusu (Toolbox)

Araç kutusunu, Window>Tools komutuyla ekranda görünür hâle getirebilir veya gizlersiniz.

Move: Taşıma aracıdır.

Magic Wand (Sihirli Değnek):
Seçim aracıdır.
Slice: Web tasarınım için gif ve
jpeg resimleri parçalar.

Pencil: Kalem aracıdır.

History Brush: Yapılan hamleleri
geri alma fırçasıdır.
Gradient (Degrade): Renk
geçişleri vermek için kullanılan
araçtır.

Dodge: Aydınlatma aracıdır.

Type: Yazı yazma aracıdır.

Rectangle: Dikdörtgen çizmek için
kullanılan araçtır.

Color Select (Damlalık): Renk
seçme aracıdır.

Zoom (Büyüteç) : Görüntüyü
uzaklaştırmak yakınlaştırmak için
kullanılır.

Background Color: Arka renktir.

Rectangular Marquee :
Dikdörtgen seçim aracıdır.
Lasso: Serbest seçim aracıdır.

Crop (Krop): Resimleri kırpmak
için kullanılan araçtır.

Healing: Doku taşıma işlemini
yapan araçtır.
Rubber Stamp: Dokuları çoğaltma
klonlama aracıdır.
Eraser: Silme aracıdır.

Sharpen, Blur, Smudge:
Keskinleştirme, bulanıklaştırma ve
çekiştirme araçlarıdır.

Path Selection: Çizilen hatları
seçmek için kullanılan araçtır.
Path (Yol): Çizgi veya şekil çizen
araçtır.

Notes: Fotoğraf üzerine bir not
dokümanı açan araçtır.
Hand (El): Sayfayı hareket
ettirmeye, kaydırmaya yarar.

Foreground Color: Ön renk

Default Colors: Varsayılan renkler.
Bu renkler siyah beyazdır.
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2.1.3.2. Paletler

Paletler, araçlar kadar sık kullanılır. Window menüsünden istenilen paletler ekranda
görünür hâle getirilebilir veya gizlenebilir.

Nevigator Paleti: Çalışma alanını yakınlaştırmak
uzaklaştırmak için kullanılır.
Info Paleti: İmlecin ekran üzerinde bulunduğu
pozisyonu ve bu pozisyondaki pikselin hem CMYK
hem de RGB olarak değerini verir.
Histogram Paleti: Renk kanalları buradan
ayarlanabilir.

Color Paleti: Renk oluşturmak için kullanılan
palettir.
Swatches Paleti: Renk seçimi için kullanılan
palettir. Bir nevi renk bankasıdır. Pantone renklere
de buradan ulaşılabilir.
Styles Paleti: Değişik stillerin bulunduğu palettir.
Stili uygulamak, burada bulunan bir stile tıklamakla
mümkündür.

History Paleti: Geri almak işlemi için kullanılan
palettir.
Actions Paleti: Bu palet ile çok sık yapılan ve
birden fazla hareketten oluşan işlemler bir makro
gibi kaydedilip daha sonra tek bir tuşa basılarak elde
edilebilir.

Layers Paleti: Resim üzerinde katmanların ayrı
ayrı izlenmesine ve ayar yapılmasına olanak
sağlayan palettir. Çalışılan resim üzerinde eklenen
her bir resim veya metin ayrı bir katman olarak yer
alır. Resmin ayrı ayrı katmanlardan oluşması daha
esnek bir çalışma olanağı sağlar.
Channels Paleti: Renk kanallarının takip
edilmesini ve ayar yapılmasını sağlayan palettir.
Paths Paleti: Çalışılan resim sayfası içerisinde yer
alan görüntünün ya da yazının vektörel anlamda
belirlenmesi anlamına gelen Path’ler ile ilgili
ayarlamaları içerir.

Resim 2.5: Paletler
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2.1.3.3. Menüler

Araç kutusu ve paletlerin açıldığı, bütün programın kontrol edildiği bölümlerdir.
Modülün ilerleyen bölümlerinde ayrıntılı olarak açıklanmaktadır.

2.2. Resim Form Ayarları

Resmin büyütülmesi, küçültülmesi, döndürülmesi, şeklinin değiştirilmesi gibi
transform işlemlerine ve çözünürlük ayarlarına resim form ayarları denir.

2.2.1. Resmin Ebadı

Resmin genişliği, yüksekliği ve çözünürlüğü yeni bir sayfa açarken belirlenebileceği
gibi açık bir dosyanın ebatları ve çözünürlüğü yeniden ayarlanabilir. Yeni bir sayfa açmak
için File>New komutu verilir ve ekrana yeni sayfa açma penceresi açılır. Bu pencereden
sayfanın ebatları ve çözünürlüğü belirlenir.

Resim 2.6: Yeni sayfa açma penceresi

Name bölümüne sayfanın ismi girilir. Preset açılır menüsünde, standart kâğıt ve
monitör ebatları vardır. Bunlardan herhangi birisi seçileceği gibi özel sayfa ebatları da
belirlenebilir. Width bölümünden sayfanın genişliği, Height bölümünden sayfanın yüksekliği
belirlenir. Resolution bölümünden ise sayfanın çözünürlüğü belirlenir. Çalışılacak resim
şayet web ortamında kullanılacaksa, çözünürlük 72 DPİ olarak belirlenmelidir. Baskıya
yönelik bir çalışma yapılacaksa, çözünürlük en az 30 DPİ olarak ayarlanmalıdır. Color Mode
bölümünden kullanılacak renk modu belirlenir. Baskı için bir çalışma yapılacaksa CMYK
renk modu, sadece bilgisayar ekranında kullanılacak bir çalışma ise RGB modu seçilmelidir.
Background Contens bölümünden ise sayfanın zemin rengi belirlenir.

Varolan bir resmin boyutlandırılması image size ve canvas size bölümlerinden
yapılabilir.
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2.2.1.1. İmaj Size (Image Size)

Görüntüyü en doğru biçimde büyültüp küçültmenin veya çözünürlüğünü yeniden
ayarlamanın yolu Image Size seçeneğidir. Resim işleme programları Bitmap tabanlı olduğu
için resmi kenarından tutup büyüttüğünüzde resim görüntü kaybına uğrayarak deforme olur.
Bu durumda resmi kenarından tutup sündürerek değil, Image Size bölümünden büyütmek
gerekir.

Resim 2.7: Image Size iletişim kutusu

Görüntüyü boyutlandırmak için Image>Image Size komutu verilerek Image Size
iletişim kutusu açılır (Şekil 2.6). Üst tarafta bulunan Width ve Height piksel cinsinden veya
yüzde olarak boyutları değiştirmeye yarar. Resolution bölümünde görüntünün çözünürlüğü
ayarlanır. İnternette kullanılacak resimler için 72 DPİ yeterlidir. Baskıda kullanılacak
resimlerin çözünürlüğü en az 300 DPİ olmalıdır. Alt tarafta yer alan Constrain Proportions
(oranları koru) seçeneği işaretli olduğunda resmin eninin boyuna olan oranı değişmez.
Resample Image seçeneği ise boyut değiştirmenin hangi biçimde yapılacağını belirtir. Resim
boyutunun değişiminde piksellere uygulanacak değişim buradan ayarlanır.

2.2.1.2. Canvas Size

Tuvali (Çalışma Alanı) büyültüp küçültmek için Canvas Size seçeneği kullanılır. Bu
komutla, Image Size’da olduğu gibi resim değil, resmin üzerinde bulunduğu çalışma alanının
(tuvali) boyutu değiştirilir.

Tuvalin boyutunu değiştirmek için Image>Canvas Size komutu kullanılarak Canvas
Size iletişim penceresi açılır. Width ve Height bölümlerinden tuvalin eni ve boyu belirlenir.
Anchor (çıpa) bölümünden ise büyümenin veya küçülmenin hangi yönde olacağı
işaretlenerek belirlenir.
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Resim 2.8: Canvas Size iletişim kutusu

2.2.1.3. Rotate Canvas

Bu seçenek resmin tümünün yönünü değiştirmeye yarar. Resmin yatay veya dikey
aynasını almak veya resmi saat yönünde veya saat tersi yönünde değişik açılarda döndürmek
için Image>Rotate Canvas seçeneği kullanılır.

2.2.2. Resmi Kırpmak

Resmin istenmeyen yerlerini bir makasla keser gibi kesip atmak için Crop aracı
kullanılır. Araç kutusundan Crop aracı alınarak resimde kalması istenilen bölgeler seçilir ve
Enter tuşuna basıldığında seçilmeyen bölgeler kesilmiş yani sayfadan atılmış olur.

2.2.3. Transform İşlemleri

Resim üzerinde çalışırken resmin tamamını veya bir bölümünü büyütüp küçültmek,
yamultmak, perspektifini almak ve döndürmek gibi değişik işlemlere gereksinim duyulabilir.
Böyle bir durumda kullanılacak seçenek transform seçenekleridir. Transform seçeneklerinin
kullanılabilmesi için resmin bulunduğu katmanın (layerin) kilitli olmaması gerekir.
Transform seçenekleri resmin tamamına uygulanabileceği gibi seçilen alanlara da
uygulanabilir.
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Resim 2.9: Edit Transform

Transform seçeneklerine Edit>Transform komutuyla ulaşılır. Transform
seçeneklerinden herhangi birisi seçildiğinde resmin etrafında tutamaçlar belirlenecektir. Bu
tutamaçları hareket ettirerek istenilen transform işlemi yapılır.

2.2.3.1. Transform Seçenekleri

Scale: Resmin eni ve boyunu değiştirmek için kullanılır.
Rotate: Resmi çevirmede kullanılır.
Skew: Resmi eğmede kullanılır.
Distort: Görüntüyü ezmek veya germek için kullanılır.
Perspective: Resme perspektif vermek için kullanılır.
Warp: Eğmek, bükmek için bu seçenek kullanılabilir.
Rotate 1800: Resmi çevirmek için kullanılır.
Rotate 900 CW: Resmi 900 saat yönünde çevirir.
Rotate 900 CCW: Resmi saat yönünün tersine 900çevirmek için kullanılır.
Flip Horizontal: Resmi yatay ters çevirmek için kullanılır.
Flip Vertical: Resmi dikey ters çevirir.

2.2.4. Resmin Renk Modu

Renk modeli, renk tanımlamaya yarayan yöntemlerdir. Renk modu ise, renk modeline
dayalı renklerle çalışma metotlarıdır. Farklı işlemler bizi farklı renk modlarına zorlar.
Baskısı yapılacak bir görüntü ile internette kullanılacak bir görüntünün renk modu
birbirinden farklıdır.
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Resmin renk modu, işin nerede kullanılacağına göre ayarlanır. Sadece bilgisayar
ekranında kullanılacak olan resimlerin renk modu ışık renkleri olan RGB (Red, Gren, Blue)
olarak ayarlanmalıdır. Matbaada basılacak bir çalışma yapılıyorsa, baskı renkleri olan
CMYK renk modu seçilmelidir.

Resim işleme programlarında genelde bulunan renk modları şunlardır: Bitmap,
Grayscale, Duotone, Indexed Color, RGB, CMYK, LAB, Multichanel Renk modları
arasında geçiş yapmak için Image>Mode menüsü kullanılır. Burada bulunan ve en çok
kullanılan renk modları şunlardır:

Resim 2.10: Image Mode menüsü

Bitmap: Görüntüyü sunmak için iki renk değerini (siyah ve beyazı) kullanır. Yani ara
tonlar yoktur. Resmi Bitmap moduna çevirebilmek için önce Grayscale modunda olması
gerekir. Yukarıdan da anlaşılacağı gibi bu renk modu tire işler için kullanılır.

Grayscale: Gri tonlamalı renk modudur. Bu renk modu siyahtan beyaza doğru
değişen 256 gri tonu ihtiva eder. Siyah beyaz çalışmalarda veya tek renkli baskı işlemlerinde
bu renk modu kullanılır.

Duotone: Resimde sadece istenilen renklerin olması için kullanılan renk modudur. Bir
başka deyişle bu renk moduyla resim, tek renk, iki renk, üç renk veya 4 renkten oluşacak
şekilde ayarlanır. Image>Mode menüsünden Duotone seçeneğini işaretlendiğinde Duotone
penceresi açılır. Bu pencereden resmin hangi renk veya renklerden oluşacağı belirlenir. Bu
renk moduna geçiş yapabilmek için resmin Grayscale modunda olması gerekir.

Indexed Color: Endekslenmiş renktir. Web ortamında kullanılacak resimler GİF
formatında kaydedilecekse bu renk modu kullanılmalıdır.
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RGB Color: Işık renkleridir. Red (kırmızı), green (yeşil), blue (mor) renkleri ve bu
renklerin karışımıyla oluşan renkleri içerir. Bilgisayar, TV gibi dijital ortamda bulunan bütün
görüntüler RGB renkleriyle oluşur. Bilgisayar ekranında veya internette kullanılacak
resimlerin renk modu RGB olarak ayarlanmalıdır. Resim işleme programında filtreler sadece
RGB renk modunda çalıştırılabilir. Yani programın bütün özellikleri kullanılmak isteniyorsa,
bu renk modunda çalışmalı ve dosyayı kaydetmeden önce istenilen renk moduna
geçilmelidir.

CMYK Color: CMYK renkleri baskı renkleridir. Bu renk modu; cyan mavisi,
magenta kırmızısı, sarı, siyah ve bu renklerin karışımından oluşur. Matbaada basılacak bir
işin renk modu, renk ayrımına gönderilirken mutlaka CMYK olarak ayarlanmalıdır. Aksi
takdirde renk ayrımı yapılamaz. CMYK renk modundayken filtrelerin hepsi çalışmaz.
Filtrelerin kullanılması gerekiyorsa, resim RGB moduna çevrilir ve fitleler kullanıldıktan
sonra tekrar CMYK moduna geçilir.
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UYGULAMA FAALİYETİ

Yukarıdaki resmin veya herhangi bir resmin form ayarlarını aşağıdaki işlem
basamakları ve öneriler doğrultusunda yapınız.

İşlem Basamakları Öneriler

 Resim işleme programında, File/Open
komutuyla çalışmak istediğiniz dosyayı
açınız.

 Dosya açmak için “Ctrl (Elma) +
O” kısayolunu kullanabilirsiniz.

 Açtığınız dosyanın hangi formatta
olduğuna ve nerde kayıtlı olduğuna
dikkat ediniz.

 Açmış olduğunuz resmi inceleyiniz.
Resmin ölçülerini, çözünürlüğünü, renk
modunu ve resmin görüntüsünü dikkatli
bir şekilde kontrol ediniz. Resme
uygulanacak işlemleri tespit ediniz.

 “Ctrl (+) veya Ctrl (-)” komutuyla
resmin görünümünü uzaklaştırıp
yakınlaştırabilirsiniz. Zoom
aracıyla da aynı işlemi
yapabilirsiniz.

 Boşluk tuşuna basılı bir şekilde
fareyi hareket ettirerek resim
üzerinde gezinebilirsiniz.

 Window>Navigator seçeneğiyle
Navigator paletini açınız. Bu palet
size resim üzerinde daha kolay
hareket etmenizi ve görünümü
küçültüp büyütmenizi sağlar.

UYGULAMA FAALİYETİ
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 Resmin ölçülerini ve çözünürlüğünü
Image/Image Size seçeneğinden
ayarlayınız.

 Resmin ölçülerini değiştirirken
Image Size seçeneğini kullanınız.
Vektörel programlarda olduğu gibi
görüntüyü büyütmek için objenin
kenarından tutup sündürürseniz
resim deforme olur.

 Baskıya yönelik bir çalışma için
çözünürlüğü en az 300 DPİ, internet
veya sadece bilgisayarda
kullanılacak bir çalışma için 72 DPİ
olarak ayarlayınız.

 Resmi büyütme küçültme
işlemlerinde, Constrain Proportios
seçeneğinin işaretli olmasına dikkat
ediniz. Bu seçenek enin boya olan
oranını muhafaza eder.

Resmi kırpmak veya kesmek için araç
kutusunda bulunan Crop aracını
kullanınız.  Krop aracını almak için “C”

kısayolunu kullanabilirsiniz.
 Krop aracıyla resimde kalmasını

istediğiniz bölgeyi seçiniz. Seçtikten
sonra Enter tuşuna bastığınızda
seçilmeyen bölgeler resimden
tamamen atılır. Solda, yukardaki
resmin kroplanmış hâli
gözükmektedir.

 Resmin tranform işlemlerini
Image/Rotate Canvas veya
Edit/Transform menülerinden yapınız.

 Resminizi Image/Rotate Canvas/Flip
Canvas Horizontal komutuyla yatay ters
çeviriniz.

 Resimde, perspektif vermek istediğiniz
bölgeyi Rectangular Marquee (Kısayolu
“M”) aracıyla seçiniz.

 Resmin tamamını döndürmek için
Image/Rotate Canvas seçeneğini
kullanabileceğiniz gibi bu işlemi
Edit/Transform bölümünden de
yapınız.

 Resmin sadece belli bir bölgesini
döndürmek, resme perspektif
vermek veya resmi eğmek bükmek
için Edit/Transform seçeneklerini
kullanmalısınız.

 Resme transform işlemlerini
uygularken resmin orijinalliğini
bozmamaya dikkat ediniz.
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 Seçilmiş olan bölgeye perspektif vermek
için Edit/Transform/Perspektif
seçeneğine tıklayınız. Bu komuttan sonra,
seçilen bölgenin kenarlarında tutmaçlar
belirecektir. Bu tutmaçları sağa sola
hareket ettirerek perspektif ayarlarını
yapınız. Yaptığınız işlemi uygulamak
için Enter tuşuna basınız.

 Edit/Transform seçenekleri aktif
değilse muhtemelen resminiz
kilitlidir. Kilidi kırmak için Layer
paletinden resmin bulunduğu
katmanı çift tıklayınız ve ekrana
gelen pencereden “OK” seçeneğini
işaretleyiniz. Bu işlemden sonra
Transform seçenekleri aktif hâle
gelecektir.

 Yaptığınız Transform seçeneklerini
uygulamak için Enter, vazgeçmek
için Esc tuşuna basmalısınız.

 Resmin, renk modunu ayarlamak için
Image/Mode menüsünü kullanınız.

 Resmin hangi renk modunda
olduğunu kontrol ediniz.

 Baskıya yönelik bir çalışma
yapıyorsanız, CMYK modunu,
internete yönelik bir çalışma
yapıyorsanız RGB modunu veya
siyah beyaz (tek renk) bir çalışma
yapıyorsanız Grayscale modunu
seçiniz.

 Çalışmayı kaydediniz (File/Save).

 Çalışmayı kaydetmek için “Ctrl +
S” kısayolunu kullanabilirsiniz.

 Kaydettiğiniz dosya formatına
dikkat ediniz.
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ÖLÇME VE DEĞERLENDİRME

A. OBJEKTİF TESTLER

Çoktan Seçmeli Test

Aşağıdaki sorularda doğru olan şıkkı işaretleyiniz.

1. Aşağıdakilerden hangisi resim işleme programlarının özelliklerinden değildir?

A) Bitmap tabanlı programlardır.
B) Matematiksel formüllerle çalışan programlardır.
C) Bu programlarda ölçü birimi pikseldir.
D) Görüntü işleme programlarıdır.

2. Aşağıdakilerden hangisi resim işleme programıyla yapılabilecek bir iş değildir?

A) Afiş yapmak
B) Dergi mizanpajı yapmak
C) Kitap kapağı yapmak
D) Katalog yapmak

3. Aşağıdakilerden hangisi yanlıştır?

A) Monitörde görüntünün en küçük birimine piksel denir.
B) Piksellerin kendi başına en ve boy değerleri yoktur.
C) Pikseller kare biçimindedir.
D) Bir pikselde, birden fazla renk bulunur.

4. Aşağıdakilerden hangisi resim işleme programının araç kutusunda bulunan araçlardan
değildir?

A) Sayfa aracı
B) Damlalık aracı
C) Degrade adacı
D) Krop aracı

5. Aşağıdakilerden hangisi pikselleri kopyalamak için kullanılan araçtır?

A) Clone Stamp aracı
B) Path aracı
C) Move aracı
D) Magic Wand aracı

6. Aşağıdakilerden hangisi resim işleme programında bulunan paletlerden değildir?

A) Layer paleti
B) Navigator paleti
C) History paleti
D) Align paleti

ÖLÇME VE DEĞERLENDİRME
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Resim A Resim B

7. 8. 9. ve 10. sorular yukarıdaki resimlere göre cevaplandırılacaktır. Resim A orijinal
ve Resim B ise resmin resim işleme programında çalışılmış hâlidir.

7. Buna göre Resim A’ya hangi işlemler uygulanmıştır?

A) Resim kroplanmış ve dekupe yapılmıştır.
B) Resmin renk modu değiştirilmiş, dekupe yapılmış, kroplanmış ve yatay ters

çevrilmiştir.
C) Resim kroplanmış, yatay ters çevrilmiş ve resme perspektif verilmiştir.
D) Resme perspektif verilmiş, tuval boyutu değiştirilmiş ve resim Path hâline

getirilmiştir.

8. Resim A’nın çözünürlüğü 72 DPI’dır. Resmin çözünürlüğünün 300 DPI yapılabilmesi
için hangi komut kullanılmalıdır?

A) AImage/Image Size
B) Image/Rotate Canvas Size
C) Image/Canvas Size
D) Image/Mode

9. Resim A’nın renk modu RGB’dir. Resmin CMYK moduna çevrilebilmesi için hangi
komut kullanılmalıdır?

A) Image/Canvas Size/CMYK
B) Image/Mode/Duotone
C) Image/Mode/RGB
D) Image/Mode/CMYK

10. Resim A internette ve Resim B baskı için kullanılacaktır. Buna göre bu resimlerin
çözünürlükleri ve renk modları ne olmalıdır?

A) Resim A: 300 DPI, CMYK. Resim B: 72 DPI, RGB
B) Resim A: 72 DPI, RGB. Resim B: 300 DPI, CMYK
C) Resim A: 72 DPI, CMYK. Resim B: 300 DPI, RGB
D) Resim A: 300 DPI, RGB. Resim B: 72 DPI, CMYK

DEĞERLENDİRME

Cevaplarınızı modül sonundaki cevap anahtarı ile karşılaştırınız ve doğru cevap
sayınızı belirleyerek kendinizi değerlendiriniz.

Ölçme sorularındaki yanlış cevaplarınızı tekrar ederek, araştırarak ya da
öğretmeninizden yardım alarak tamamlayınız.
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B. UYGULAMALI TEST

Öğrenme faaliyetinde kazandığınız becerileri aşağıdaki kontrol listesine göre
değerlendiriniz.

DEĞERLENDİRME ÖLÇÜTLERİ Evet Hayır

1. Resim işleme programında resmi açtınız mı?

2. Resmin ölçülerini ve çözünürlüğünü tespit ettiniz
mi?

3. Resmin çözünürlüğünü ayarladınız mı?

4. Resmin ölçülerini ayarladınız mı?

5. Resmi kırptınız mı?

6. Resminizin katmanı kilitli ise kilidini açtınız mı?

7. Resmi yatay ters çevirdiniz mi?

8. Resme perspektif verdiniz mi?

9. Resmin renk modunu ayarladınız mı?

10. Resmi kaydettiniz mi?

DEĞERLENDİRME

Faaliyet değerlendirmeniz sonucunda “Hayır”ı işaretleyerek yapamadığınız işlemleri
tekrar ediniz.

Tüm işlemleri başarıyla tamamladıysanız bir sonraki faaliyete geçiniz.
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ÖĞRENME FAALİYETİ–3

Bu faaliyet ile gerekli ortam sağlandığında rötuş araç ve filtrelerini, seçim araçlarını
ve Layer paletini tekniğine uygun olarak kullanabileceksiniz.

Resim işleme programıyla çalışmaya alıştıktan sonra fark edeceğiniz ilk şeylerden
biri, reklamcılık ve gazete, dergi fotoğrafçılığında kullanılan görüntü rötuşlama teknikleri
olacaktır. Dergilerde, kataloglarda ve diğer basılı medyada kullanılan resimlerin bir dijital
rötuşlamadan geçtiğini göreceksiniz. Bu tür resimleri teknik ve beceri açısından inceleyiniz.
Dört renkli dergi ve broşürlerde gördüğünüz otomobil resimlerini inceleyiniz. Ön plana ve
vurgulara dikkat ediniz. Işıklardaki yansımaları inceleyiniz. Nasıl, iyi görünüyorlar mı?
Yoksa görünmüyorlar mı? Neredeyse bütün reklam görüntüleri rötuşlanır. Bu işi yapanlar da
son derece profesyonel kişilerdir. Onlardan çok şey öğrenebilirsiniz.

Ayrıca çevrenizde bulunan film servis bürolarına veya matbaalara giderek
grafikerlerin rötuş araç ve filtrelerini, seçim araçlarını, Layer paletini nasıl kullandıklarını
araştırınız. Bu konuda eğitim veren internet sitelerini ziyaret ediniz. Bu konuda uzman
kişilerden yararlanınız. Topladığınız bilgileri arkadaşlarınızla paylaşınız.

3. RÖTUŞ

3.1. Tanımı

Fotoğrafın orijinalliğini koruyarak istenmeyen görüntülerin atılması ve fotoğrafın
güzelleştirilmesi, albenisinin artırılması adına yapılan işlemlerin hepsine birden rötuş denir.

Kitaplarda, dergilerde, afişlerde ve diğer basılı materyallerde kullanılan resimlerin
büyük bir kısmı dijital rötuşlamadan geçer. Bu sayede fotoğraflar üzerinde istenmeyen
görüntüler atılır, fotoğraflar daha pürüzsüz ve keskin hâle getirilir. Değişik ışık ayarlamaları
ve vurgular yapılır. 30 yıl önce çekilmiş ve dolayısıyla kırılmış, çatlamış, solmuş bir fotoğraf
dijital rötuşlama ile daha bugün çekilmiş gibi net, parlak ve pürüzsüz bir fotoğraf hâline
getirilebilir.

Rötuş işlemini yapabilmek için rötuş araçlarını iyi öğrenmek gerekir. Resim işleme
programında rötuş işlemi için kullanılan birçok araç vardır. Bunların her birinin görevi
farklıdır.

ÖĞRENME FAALİYETİ–3

AMAÇ

ARAŞTIRMA
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3.2. Rötuş Araçları

Rötuş araçlarından herhangi birisi seçildiğinde, menülerin hemen altında Tool Options
(Araç secenekleri) çubuğu açılır. Bu çubuktan seçilen aracın fırça büyüklüğü, şekli ve aracın
diğer seçenekleri ayarlanır. Zira resim işleme programı, rötuş araçlarını bir fırça olarak
görür. Bir başka deyişle, rötuş araçlarının hepsi birer fırça ve bu fırçaların yaptığı işlemler
birbirinden farklıdır.

3.2.1. Clone Stamp Aracı

Damga aracı olarak da adlandırılır. Dokuları çoğaltma, klonlama aracıdır. Bu araçla
kırıklar, çizikler, kırışıklar ve pürüzler yok edilebilir. Sivilce ve benler bu araçla gizlenebilir.
Kısacası resminizde istemediğiniz görüntüleri bu araçla yok edebilir veya gizleyebilirsiniz.

Resim 3.1: Orijinal Resim 3.2: Resme Clone Stamp Aracı Uygulandı

Kısayolu “S” harfidir. Araç alındıktan sonra istenilmeyen bölgeyi kapatacak pikseller
kopyalanır. Kopyalama için alt tuşuna basılı bir şekilde fare tıklanır. Bu şekilde tıklanan
bölgedeki pikseller kopyalanmış olur. Ardından fare ile kapatmak istenilen bölgeye
tıklandığında kopyalanan doku yapıştırılır. Brush (Fırça) menüsünden fırçanın tipi ve
büyüklüğü ayarlanabilir.

3.2.2. Pattern Stamp Aracı

Özel doku sürme aracıdır. Seçili olan dokuyu tıklanan bölgeye aktarır. Araç
seçildiğinde ekranın üst kısmında fırça ve doku seçenekleri aktif hâle gelir. Buradan fırça ve
doku seçilerek doku resim üzerine sürülebilir.

3.2.3. Blur Aracı

Görüntü üzerinde fluluk meydana getiren, bulanıklaştırma aracıdır. Blur aracı
seçildiğinde, ekranın üst bölümünde Tool Options çubuğu ortaya çıkar. Buradan Blur
aracının seçenek ayarları yapılabilir. Pürüzler, kırışıklıklar bu araçla gizlenebilir. Genelde
yüz rötuşlarında kullanılan araçtır.
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Resim işleme programı, Blur aracını ve diğer rötuş araçlarını fırça olarak görür. Bu
nedenle Brushes paletinden uygun fırça büyüklüğü ve şekli seçilir veya ayarlanır.

Resim 3.3: Orijinal Resim 3.4: Orijinale Blur aracı uygulandı

3.2.4. Sharpen Aracı

Blur aracının tam tersidir. Keskinleştirme aracıdır. Blur aracı piksel değerlerini
yumuşatırken, Sharpen aracı bunları sertleştirir ve komşu pikseller arasındaki kontrastı
(zıtlığı) artırır. Hafif bulanık hatları az seviyede keskinleştirmek için kullanılır. Blur aracıyla
aynı araç kutusu bölmesinde yer alır.

3.2.5. Smudge Aracı

Smudge aracı aynen bir parmağa benzer ve o şekilde çalışır. Renkleri çekiştirir. Blur
ve Sharpen araçlarıyla aynı araç kutusu bölmesinde yer alır. Brushes paletinden aracın
genişliği ve tipi ayarlanabilir.

Resim 3.5: Orijinal Resim 3.6: Orijinale Sharpen ve Smudge araçları uygulandı
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3.2.6. Patch Aracı

Yama aracıdır. Lasso aracı gibi bir alanı seçer. Alan taşınır, temiz doku seçilir.
Böylece daha büyük alanlara doku taşıma işlemi yapılır. Kısayolu J’ dir.

3.2.7. Brush Aracı

Brush (fırça), boyama fırçasıdır. B tuşuna basılarak veya araç kutusundan da alınabilir.
Yatay ve dikey olarak kısıtlanmış düz bir çizgi boyunca boyamak gerektiğinde, fırçayı
sürüklerken Shift tuşuna basılı tutulur. İki nokta arasına düz bir çizgi çekmek için ise, tuval
üzerinde iki noktaya tıklanıp daha sonra Shift tuşuna basılı tutularak ikinci nokta belirlenir.
Böylece iki nokta arasına çizgi çekilir.

Resim 3.7: Orijinal Resim 3.8: Orijinale Brush aracı uygulandı

3.2.8. Eraser (Silgi) Aracı

Resim üzerinde, silme işleri için kullanılan araçtır. E tuşu ile kısayolu
kullanılabileceği gibi araç kutusundan Eraser aracı seçilebilir. Diğer araçların karakteristik
özelliklerini taklit edebilen bir araçtır. Yumuşak konturları, beyazlatıcı sürülmüş bir sulu
boya fırçası gibi siler. Bir kalemmiş gibi bir dizi pikseli veya görüntünün yoğunluğunu
silebilir. Standart silgi gibi de kullanılabilir. Araç özellikleri çubuğundan, silginin nasıl
çalışacağı, biçimi ve ne kadar silme işlemi yapacağı belirlenebilir.

3.2.9. Dodge Aracı

Dodge, fotoğrafçılıktan gelen bir karanlık oda terimidir. Fotoğrafçı, karanlık odada
agrandizör ile fotoğraf kâğıdına yansıtılan görüntü arasına delikli bir plaka yerleştirir. Bu,
ışığın bir kısmını tutar ve fotoğraf banyo edildiğinde plakanın ışığı kestiği alanların daha
aydınlık olmasını sağlar. Dodge aracı, aynen karanlık odadaki eş değeri gibi çalışır. Yani
Dodge aracı, resmin belli bir bölgesini aydınlatmak veya parlatmak için kullanılır.

Dodge aracı, “O” tuşuna basılarak veya araç kutusundan seçilir. Aracın ayarları araç
seçenekleri (Tool Options) çubuğundan yapılır. Dodge aracının Tool Options çubuğunda üç
farklı seçeneği bulunur. Bunlar; Shadows, Midtones ve Highlights’tır. Bu seçenekler aracın
etkileyeceği pikselleri gösterir.
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Midtones: Standart seçenektir. Ara tonlu pikselleri etkilemek için ve hangi işlemi
yapacağınızı bilemediğiniz durumlarda kullanılır.

Shadows: Gölgeleri daha aydınlık veya daha karanlık hâle getirmek ve bu sırada daha
aydınlık pikselleri etkilememek için kullanılır.

Highlights: Açık renkli alanları daha açık hâle getirir ve koyu renkli alanları olduğu
gibi bırakır.

Resim 3.9: Orijinal resim Resim 3.10: Orijinale Dodge aracı uygulandı

3.2.10. Burn Aracı

Dodge aracının tam tersi olan Burn aracı, küçük bir alanı aydınlatmak yerine karartır.
Karanlık odada, üzerine delik açılan bir plakayla veya elle ışık engellenerek ışığın sadece
aşırı pozlanacak yere ulaşması sağlanır. Burn aracının ikonu, küçük bir ışın demetini
geçirecek hâle getirilmiş el şeklindedir.

Burn aracı, Dodge aracı ile aynı araç kutusu bölmesinde yer alır. Resmin belli bir
bölgesini bronzlaştırmak veya karartmak için Burn aracı araç kutusundan seçilerek Tool
Options (araç seçenekleri) bölümünden aracın fırça ayarları yapılır ve resme uygulanır.

3.2.11. Sponge Aracı

Sponge, sünger anlamına gelir ve bir karanlık oda tekniğidir. Karanlık oda tekniğinde
bir resim banyoda yeterince koyulaşmazsa veya az pozlanması ya da renklerinin zayıf olması
durumunda, karanlık oda teknisyeni süngere bazı banyo kimyasalları dökerek, bunu
doğrudan banyodaki nemli baskının üzerine sürterek resmi kurtarır. Süngerin hafifçe
temasından ve kimyasalların nüfuzundan oluşan bu işlem, çoğu zaman hiçbir işe yaramayan
bir resimle, iyi resim arasındaki farkı oluşturur. Elbette, doğru ışıkta pozlamanın yerini
tutamaz.

Resim işleme programında, Sponge aracı da aynı işi yapar. Renkli bir görüntüde belli
bir bölgenin renk doygunluğunu artırmak veya azaltmak için kullanılır. Siyah beyaz bir
görüntüde uygulanan alanın kontrastını artırır veya azaltır. Sponge aracını kullanırken Araç
Seçenekleri çubuğundan ayarları yapılarak rengi yoğunlaştıracağı mı (doygunlaştırma.
saturate), yoksa solduracağı mı (doygunluğunu azaltma, desaturate) belirlenir.
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Resim 3.11: Orijinal resim Resim 3.12: Sponge aracı ile renkler doygunlaştırıldı.

3.3. Rötuş Filtreleri

Fotoğraf problemlerini çözmek, resmin genel görünümünü değiştirmek, zemin
oluşturmak gibi birçok işlem için kullanılan filtreler rötuş yapmak için de kullanılabilir.
Rötuş filtrelerinin başlıcaları; Noise, Blur ve Sharpen’dır.

Filtreler transparan (saydam) tabakalara uygulanmaz. Tabakanın bir kısmı transparan
ise sadece renkli kısma uygulanır. Eğer seçili bir bölge varsa sadece bu bölgeye, yoksa bütün
tabakaya uygulanır. Bir seferde sadece bir filtre uygulanabilir. BMP uzantılı bitmap
dosyalara filtre uygulanmaz. Bazı filtreler sadece RGB renk modundaki dosyalara
uygulanabilir.

3.3.1. Noise

Noise filtresinin dört farklı seçeneği vardır.

Resim 3.13: Noise filtreleri
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3.3.1.1. Add Noise Filtresi

Görüntüye parazit ekler ve bu parazitlerle resmin bütünleşmesini sağlar. Genellikle
resmin tamamına veya bir kısmına doku oluşturmak için kullanılır. Add Noise komutu
verildiğinde ekrana gelen, Add Noise iletişim kutusundaki amount değeri parazit
yoğunluğudur. 1 ile 999 arasında değer alabilir. Uniform seçeneğini işaretlerseniz, her bir
piksel için amount değeri kadar + veya - renk rastgele seçilir. Eğer Gaussian seçeneğini
işaretlerseniz bu renk seçimi Gaussian çanına bağlı olarak hesaplanır. Genellikle Gaussian
seçeneğinde daha parazitli bir görünüm oluşur. Monochromatic seçeneği işaretliyse
parazitler siyah-beyaz arasında değer alabilir.

Resim 3.14: Orijinal Resim 3.15: Add Noise filtresinin etkisi

3.3.1.2. Despeckle Filtresi

Bu filtre, resimdeki en büyük farka sahip renk değişim yerlerini koruyarak diğer
yerleri bulanıklaştırır. Böylece resmin ayrıntıları ve çizgileri korunurken genelde parazitler
ve aşırı netleşmiş pikseller yumuşatılır. Tarayıcıda kötü taranmış resimleri düzeltmek için
kullanılabilir. Örneğin tarama sonucunda tram noktaları veya kâğıt yüzeyinin grenleri belli
oluyorsa, bunları yumuşatmak için Despeckle filtresi uygulanabilir. Bu filtrenin etkisini
görebilmek için 3-4 kez filtreyi uygulamak gerekebilir.

Resim 3.16: Orijinal Resim 3.17: Despeckle filtresinin etkisi
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3.3.1.3. Dust & Scratches Filtresi

Bu filtre resimdeki çizik, kırık gibi kusurlu bölgelerde hatalı yerleri çevresiyle
kaynaştırmak için kullanılır. İletişim kutusundaki threshold değeri, hatalı bölge ile ona
komşu bölge piksellerinin değerini analiz etmek için kullanacağı değerdir. Radius değeri ise
hatalı bölgenin temizleneceği aralığı belirler. Çalışmalarda her iki değeri dengeli kullanmak
en iyi sonuç almayı sağlar. Eski fotoğraflar için çok yararlı bir filtredir.

Resim 3.18: Orijinal Resim 3.19: Dust & Scratches filtresinin etkisi

3.3.1.4. Median Filtresi

Median filtresi resimde veya seçili bölgedeki piksellerin parlaklıklarını harmanlar ve
istenmeyen parazitleri azaltır. Radius değeri (1-16 arası) her bir pikselin kaç piksel
yarıçaptaki bir bölgeyi inceleyip harmanlayacağını gösterir. Yüksek değerler kullanılmalıdır.

Resim 3.20: Orijinal Resim 3.21:Median filtresinin etkisi

3.3.2. Blur Filtresi

Bu filtre resmi veya uygulanan bölgeyi flulaştırır. Blur, fotoğraflarda kontrastı
azaltmak ve renk geçişlerinde oluşan parazitleri ortadan kaldırmak için kullanılır. Hafif bir
bulanıklık efekti verir. Bilgisayarımızda oluşturulan grafik çalışmalarında farklı bir yapı
kazandırmak için de kullanılmaktadır. Blur filtresinin yanında, 5 tane daha Blur filtresi
vardır.
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3.3.2.1.Blur More Filtresi

Blur filtresinin yaptığı işi yapar. Sadece bulanıklaştırma gücü Blur'un 3-4 katıdır.

Resim 3.22: Blur filtreleri

3.3.2.2.Gaussian Blur Filtresi
Bu filtre, bulanıklaştırma derecesini ayarlamamıza olanak vererek görüntünün hafifçe

yumuşatılmasından tüm görüntüyü kalın bir sisle kaplamaya kadar değişen efektler yaratır.
Adını, renk değerlerinin değişimini Gaussian çanı denilen eğriyle eşleştirmesinden alır. Bu
filtrenin iletişim kutusunda görülen Radius değeri bulanıklık değeridir ve 0.1-250 arasında
olabilir. Ayrıca grafiklerimize gölge kazandırmak için ve 3 boyut çalışmalarında yaygın
olarak kullanılır.

Resim 3.23: Orijinal Resim 3.24: Gaussian Blur filtresinin etkisi

3.3.2.3. Radial Blur Filtresi

Bir resmi dairesel olarak döndürebilir veya merkezden itibaren yayarak derinlik
verebilir. İletişim kutusundaki telden yapılmış ön izleme biraz dikkat ve alışkanlık gerektirir.
Spin seçeneği resmi veya seçili alanı dairesel döndürürken Zoom seçeneği merkezden
itibaren yayılmayı sağlar.



44

Resim 3.25: Orijinal Resim 3.26: Radail Blur filtresinin etkisi

3.3.3. Sharpen Filtresi

Bu filtre birbirine komşu pikseller arasındaki kontrastı artırarak resmi netleştirir.
Genellikle taranmış resimlerde rötuş işlemlerinden sonra veya resim üzerinde transform
komutları kullanıldıktan sonra oluşan bozulmaları gidermek amacıyla kullanılmaktadır.
Sharpen filtresinin çeşitleri aşağıda verilmiştir.

Resim 3.27: Orijinal Resim 3.28: Sharpen filtresinin etkisi

Sharpen Edges filtresi: Sharpen filtresi gibi çalışır. Tek farkı resimde veya seçim
bölgemizin içinde bulunan kenarlara etki etmemesidir.

Sharpen More filtresi: Sharpen filtresinin 3-4 kat kuvvetli etki yapanıdır.

Unsharp Mask filtresi: Bu gruptaki en enteresan filtredir. Bir resmin kenarlarının
netliğini artırır. İletişim kutusundaki amount değeri efektin yoğunluğunu belirler. %
cinsinden 1-500 arası bir değer alabilir.

3.4. Taşıma ve Seçim Araçları

Resmi veya resmin belli bir bölgesini seçmek için kullanılan araçlardır. Resim işleme
programında, resimleri işleyebilmek için bu araçları kullanmayı bilmek gerekir.
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3.4.1. Taşıma (Move) Aracı

Seçilmiş alanları, katmanları, şekilleri ve yazıları taşımak için kullanılan araçtır. “V”
tuşu ile veya araç kutusundan seçilebilir.

3.4.2. Marquee (Seçim) Araçları

Resim 3.29: Marquee araçları

Seçim araçları araç kutusunun üst tarafında yer alır. Seçim yaptıktan sonra ikinci bir
alanı da seçili hâle getirmek için Shift tuşuna basılır. Dört farklı Marquee aracı vardır.

Rectangular Marquee aracı: Dikdörtgen veya kare (Shift tuşuna basarak) alanları
seçmek için kullanılır.

Eliptical Marquee aracı: Dairesel alanların seçiminde kullanılan araçtır.

Single Row Marquee aracı: Yatay tek bir piksel sırasını seçer.

Singe Column Marquee aracı: Dikey olarak tek bir piksel sırasını seçmek için
kullanılan araçtır.

3.4.3. Lasso (Kement) Araçları

Düzensiz şekilleri seçmek için kullanılan araçlardır. Birçok insanın olduğu bir
fotoğraftan sadece birini seçmeniz veya bir çiçek demetinden sadece bir çiçek seçmeniz
gerekebilir. Bu tür durumlarda seçim için Lasso araçları kullanılır. Lasso araçları, araç
kutusunda Marquee araçlarının hemen altında bulunur. Bu araçlar “L” tuşuna basılarak veya
araç kutusundan seçilebilir.

Resim 3.30: Lasso araçları
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Lasso (Kement) aracı: Araç alındıktan sonra seçilecek bölgenin etrafında sürüklenir.
Sürüklenirken kesintisiz bir çizgi oluşur. Görüntünün etrafında dolanıp ilk tıklanan noktaya
gelindiğinde farenin tuşu bırakılır. Şekli etrafına çizilen seçim sınırlarının iki uç noktası
otomatik olarak birleşir ve seçilen alanı oluşturur. İkinci bir seçime geçmek için Shift tuşuna
basılı tutularak seçime devam edilir.

Polygonal Lasso (Poligon Kement) Aracı: Aynen standart Lasso aracı gibi çalışır.
Aradaki tek fark, isminden de anlaşılacağı gibi düzensiz geometrik şekillerin seçimine izin
vermesidir. Ayrıntılı seçimler yaparken kullanılması daha kolaydır, çünkü daha kolay idare
edilebilir. Sadece, standart Lasso’da olduğu gibi bir çizgiyi sürüklemek yerine, Polygonal
Lasso ile nokta nokta tıklanarak seçim yapılır.

Magnetic Lasso (Manyetik Kement): En sık kullanılan araçlardan biridir. Bir şeklin
etrafında sürüklendiğinde kendiliğinden nokta ekleyerek bu kenarlara oturur. Bu araç
kenarları kontrast farkına dayanarak belirlediği için belirli bir zeminin üzerine oturan
düzensiz şekillerin seçiminde etkilidir. Parametreleri belirlemek için Tool Options (Araç
Seçenekleri) çubuğu kullanılır.

Manyetik Kement aracının, araç seçenekleri şunlardır:

Detection Witdh (Tespit Genişliği): Lasso’nun saptayabilmesi için kenarların ne
kadar yakın olması gerektiğini belirler.

Edge Contrast (Kenar Kontrastı): Lasso’nun bunları farklı olarak algılayabilmesi
için her pikselin parlaklık değerinin birbirinden ne kadar farklı olması gerektiğini belirler.

Frequency (Frekans): Lasso’nun ne kadar sıklıkta sabit nokta atadığını belirler.

Resim 3.31: Şekillere göre kullanılacak seçim araçları
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3.4.4. Magic Wand (Sihirli Değnek)

Sihirli değnek diye de adlandırılan bu araç diğer seçim araçlarından farklıdır. Diğer
seçim araçları, pikselleri resim üzerindeki konumlarına bağlı olarak seçim yapan araçlardır.
Sihirli Değnek aracı ise seçim yaparken renk değerlerini esas alır. Pikselleri renk benzerliği
esasına göre seçer. İkinci bir seçim yapılırken Shift tuşuna basılırsa, seçilen alanlar
birleştirilir.

Sihirli değnek aracının ayarları Araç Seçenekleri çubuğundan yapılır. Burada bulunan
Tolerance (Tolerans) bölümüne ne kadar az değer girilirse, aracın renk farklarına göstereceği
tolerans da o kadar az olacaktır.

3.5. Seçim (Select) Menüsü

Seçim işlemlerinde seçim araçlarının yanında Select menüsünü de kullanmak
gerekebilir. Select menüsünde bulunan seçeneklerden en çok kullanılanları şunlardır:

Select all: Resmin tamamını seçmek için kullanılır.

Deselect: Seçilen alandan seçimi kaldırır.

Reselect: Seçili hâlden çıkarılan alanı yeniden seçili hâle getirir.

Inverse: Seçili alanın dışındaki bütün alanı seçili hâle getirir.

Feather: Seçilen kenarları yumuşak geçişli hâle getirir. Bu, özellikle bir nesneyi bir
resimden seçip diğerine yapıştırmak istenildiğinde önemlidir. Nesneyi yerine yerleştirirken
hafif bir bulanıklık verir. Feather işleminin kaç piksele uygulanacağını belirlemek için
Feather Selection penceresi kullanılır.

Resim 3.32: Orijinal Resim.3.33: Feather uygulandı
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3.6. Layers (Katman) Paleti

Layers paleti, çalışılan resim üzerindeki katmanların ayrı ayrı izlenebilmesine ve
gerekli ayarların yapılabilmesine olanak sağlar. Çalışılan resim üzerine eklenen her yeni bir
resim ya da metin parçası ana resim üzerinde ayrı bir katman olarak yer alır. Bu sayede her
katmana ayrı işlemler uygulanabilir. Eklenen resimler, ana resim üzerine yapıştırılmaz ve
istenildiği zaman Layers paletinden silinerek resimden çıkarılabilir. Bu şekilde çalışmaya
oldukça esneklik kazandırılmış olunur ve istenildiği zaman hatalı veya bozuk katman resim
bozulmadan çıkarılır. Layers paleti ekranda değilse, Window/Layers komutu uygulanarak
palet açılır.

Resim 3.34: Layers paleti

Paletin sol üst köşesinde bulunan Çek menüden katmanın harmanlama modu seçilir.
Bu genelde özel bir çalışma yapılmayacaksa Norm mod olarak ayarlanır.

Opacity bölümünden seçili olan katmanın opaklığı ayarlanır. Değer düştükçe katmanın
ışık geçirgenliği artar. Çok sayıda katmanla çalışırken katmanların sırası değiştirilebilir.
Katman seçilerek aşağı veya yukarı alınabilir. Kilitli bir katmanın kilidini açmak için
katmanın üzerine çift tıklanır.

Layer paletinin sağ üst köşesinde bulunan oka tıklanarak ekrana gelen menüden; yeni
katman oluşturulabilir (New Layer), katman çoğaltılabilir (Duplicate Layer), seçili katman
silinebilir (Delete Layer) veya katmanlar birleştirilebilir. Merge Down komutu, seçili
katmanla alttaki katmanı birleştirir. Merge Visible, açık olan katmanları birleştirir. Flatten
Image ise bütün katmanları birleştirir. Katmana çift tıklayarak ekrana gelen Layer Style
penceresinden katmana değişik efektler uygulanabilir. Katmanı gizlemek için katmanın sağ
tarafında bulunan göz simgesine tıklanır.
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UYGULAMA FAALİYETİ

Yukarıdaki resmin veya uygun bir resmin rötuş çalışmasını aşağıdaki işlem
basamakları ve öneriler doğrultusunda yapınız.

İşlem Basamakları Öneriler

 Resmi inceleyerek yapılacak işlemleri
belirleyiniz ve işe pürüzleri, kırıkları yok
ederek başlayınız.

 Resmi dikkatli bir şekilde
inceleyiniz, yapılacak işlemleri
belirleyiniz.

 Pürüzleri, kırıkları, kırışıklıkları
veya pislikleri yok etmek için
Clone Stamp (Damga) aracını
kullanınız.

 Damga aracının fırça büyüklüğünü
ve tipini yok etmek istediğiniz
bölgeyi referans alarak araç
seçeneklerini belirleyiniz.

 Bulandırmak istediğiniz bölgeyi seçerek
flulaştırınız.

 Flulaştırmak istediğiniz bölgeyi
seçmek için seçim araçlarını
kullanınız. Seçim yapacağınız
bölge gemometrik ise Marquee,
değil ise Lasso araçlarını
kullanınız.

 Flulaştırmak için Blur aracını veya
Filter/Blur komutunu uygulayınız.

UYGULAMA FAALİYETİ
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 Resimde ön plana çıkmasını istediğiniz
bölgeyi aydınlatınız, arka planda durmasını
istediğiniz bölgeyi karartınız.

 Resim üzerinde daha rahat çalışmak için
resmi katmanlara ayırabilirsiniz.
Aydınlatacağınız bölgeyi seçtikten sonra
Layer menüsünden New/Layer via Copy
komutunu verirseniz seçtiğiniz bölgeyi
yeni bir katman hâline getirirsiniz. Bu da
size daha rahat bir çalışma sağlayabilir.
Çünkü uyguladığınız araç sadece seçili
katmanı etkileyecektir. Aşağıdaki resimde
araba seçilerek yeni bir katman hâline
getirildi.

 Aydınlatmak için Dodge aracını
kullanınız.

 Karartmak için Burn aracını
kullanınız.

 Katmanlarla çalışmanız hem daha
iyi netice almanızı hem de daha
rahat çalışmanızı sağlar. Örneğin
arabayı seçip yeni bir katman
hâline getirdiğinizde daha sonra
arabayı seçmek gerektiğinde tekrar
seçmek için uğraşmazsınız. Sadece
katmanı seçmeniz yeterli olacaktır.

 Katmanlarla çalışırken seçili olan
katmana dikkat ediniz. Çünkü
uyguladığınız işlem sadece seçili
katmanı etkileyecektir.

 Parlatılan bölgelerde rahatsız edici pürüzler
ortaya çıkmış olabilir. Bunları yok ediniz.

 Pürüzleri yok etmek için Clone
Stamp (Damga) aracını kullanınız.

 Bazı bölgeler çok aydınlatılmış
olabilir. Bu bölgeleri Burn aracı ile
kapatınız.

Resmi tekrar kontrol ediniz. Rötuş işleminin tamamlandığını düşünüyorsanız
dosyanızı kaydediniz.
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ÖLÇME VE DEĞERLENDİRME

A. OBJEKTİF TESTLER

Çoktan Seçmeli Test

Aşağıdaki sorularda doğru olan şıkkı işaretleyiniz.

1. Aşağıdakilerden hangisi resim üzerinde seçilen bölgeyi taşımak amacı ile kullanılan
araçtır?

A) Dodge aracı
B) Sponge aracı
C) Move aracı
D) Lasso aracı

2. Katmanları kontrol etmek, çoğaltmak ve silmek gibi işlemler hangi paletten
yapılabilir?

A) Channels paleti
B) Layers paleti
C) Path paleti
D) Actions paleti

3. Aşağıdakilerden hangisi resmi keskinleştirmek için kullanılan araçtır?

A) Sharpen aracı
B) Marquee aracı
C) Brush aracı
D) Patch aracı

4. Aşağıdakilerden hangisi pikselleri renk değerlerine göre seçen seçim aracıdır?

A) Rectangular Marquee aracı
B) Magic Wand aracı
C) Magnetic Lasso aracı
D) Move aracı

5. Aşağıdakilerden hangisi resim üzerinde silme işlemleri için kullanılır?

A) Eraser aracı
B) Patch aracı
C) Burn aracı
D) Brush aracı

ÖLÇME VE DEĞERLENDİRME
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Bundan sonraki soruları yukarıdaki resme göre cevaplayınız.

6. Aşağıdakilerden hangisi araba üzerinde bulunan lekeleri kaldırmak için kullanılacak
araçtır?

A) Clone Stamp
B) Magic Wand
C) Poligonal Lasso
D) Patch

7. Aşağıdakilerden hangisi arabanın yeni bir katman yapılması için izlenecek yoldur?

A) Araba Magic Wand aracı ile seçilerek Layers paletinden New komutu verilir.
B) Araba Magnetic Lasso aracı ile seçilerek Layers menüsünden New/Layer via

Copy komutu verilir.
C) Araba Marquee aracı ile seçilerek Layers menüsünden New/Layers via Cut

komutu verilir.
D) Araba Magnetic Lasso aracı ile seçilerek Layers paletinden New komutu verilir.

8. Arabanın daha fazla dikkat çekmesi amacı ile arabayı ön plana çıkarmak (diğer
bölgeleri flulaştırmak) için yapılacak işlem aşağıdakilerden hangisidir?

A) Burn aracını araba üzerinde kullanmak
B) Arka fonun bulunduğu katmana Filter/Sharpen filtresini uygulamak
C) Arabanın bulunmadığı katmana Fitler/Blur filtresini uygulamak
D) Arabanın bulunduğu katmana Fitler/Noise filtresini uygulamak

9. Aşağıdakilerden hangisi arabayı parlatmak için kullanılacak araçtır?

A) Burn aracı
B) Brush aracı
C) Smudge aracı
D) Dodge aracı
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10. Arabanın renk yoğunluğunu artırmak için aşağıdakilerden hangi araç kullanılmalıdır?

A) Sponge aracı
B) Burn aracı
C) Pattern Stamp aracı
D) Sharpen aracı

DEĞERLENDİRME

Cevaplarınızı modül sonundaki cevap anahtarı ile karşılaştırınız ve doğru cevap
sayınızı belirleyerek kendinizi değerlendiriniz.

Ölçme sorularındaki yanlış cevaplarınızı tekrar ederek, araştırarak ya da
öğretmeninizden yardım alarak tamamlayınız.

B. UYGULAMALI TEST

Öğrenme faaliyetinde kazandığınız becerileri aşağıdaki kontrol listesine göre
değerlendiriniz.

Değerlendirme Ölçütleri Evet Hayır

1. Resim üzerinde bulunan pürüzleri, kırıkları resmin
orijinalliğini bozmadan yok ettiniz mi?

2. Resmin belli bir bölgesini flulaştırdınız mı?

3. Resmin belli bir bölgesini seçim araçlarını
kullanarak seçtiniz mi?

4. Seçim işlemlerinde Select menüsünü kullandınız
mı?

5. Resim üzerinde aydınlatma, karartma,
keskinleştirme ve renk yoğunluğunu artırma
işlemlerini yaptınız mı?

6. Resim üzerinde belli bir bölgeyi yeni bir katman
hâline getirdiniz mi?

7. Layers paletini kullandınız mı?

DEĞERLENDİRME

Faaliyet değerlendirmeniz sonucunda “Hayır”ı işaretleyerek yapamadığınız işlemleri
tekrar ediniz.

Tüm işlemleri başarıyla tamamladıysanız bir sonraki faaliyete geçiniz.
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ÖĞRENME FAALİYETİ–4

Bu faaliyet ile gerekli ortam sağlandığında resim işleme programında bir resmin renk
ayarlarını tekniğine uygun olarak yapabileceksiniz.

 Çevrenizde bulunan baskı öncesi hazırlık bürolarına, matbaalara,

fotoğrafçılara veya ajanslara giderek burada çalışanların, resmin renk

ayarlarını nasıl yaptıklarını araştırınız.

 Bu konuyla ilgili web sitelerini ziyaret ediniz.

 Topladığınız bilgileri arkadaşlarınızla paylaşınız.

4. RENK AYARLARI
Önceki derslerimizde renk modlarını görmüştük. RGB’nin bilgisayar ekranında

kullanılacak resimlerde, CMYK renk modunun ise basılacak resimlerde kullanılacağını artık
biliyoruz. Bir resim üzerinde renk ayarı yapılırken görüntüleneceği biçimde ayarlama
yapmanın daha iyi sonuç vereceğini unutmamak gerekir.

Bir resim veya fotoğrafın parlaklık, kontrast, renk doygunluğu, renk değerleri, tonları
ve açıklığı gibi ayarlara kısaca renk ayarları denir.

4.1. Adjusments Menüsü

Resim işleme programında renk ayarları Image menüsünde bulunan Adjusments
seçeneklerinden yapılır. Adjusments menüsünde bulunan seçeneklerle; resmin açıklığı-
koyuluğu, aydınlığı, tonları, parlaklığı, kontrastı, renk değerleri ve renk doygunluğu
ayarlanabilir. Burada bulunan seçenekleri bilinçli kullanmak gerekir. Resim renk ayarlarını
yaparken orijinalliği bozmamaya dikkat etmek gerekir.

ÖĞRENME FAALİYETİ–4

AMAÇ

ARAŞTIRMA
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Resim 4.1: Adjusments menüsü

Adjusments menüsünde bulunan seçenekler şunlardır:

Levels, Curve, Brigthness/Contrast, Color Balance, Selective Color,
Hue/Saturation, Desaturate, Replace Color ve Variations’dur.

4.1.1. Levels

Levels, görüntünün parlaklığını ayarlamak için kullanılır (Image / Adjusments /
Levels - Ctrl+L veya Command+L). Bazı fotoğraflar gereğinden açık veya koyu olabilir.
Bazı fotoğraflar da karanlık çıkmış olabilir. Bu tür fotoğrafların ışık miktarlarını Levels
menüsünden ayarlayabiliriz. Levels iletişim kutusunda bir histogram görülür ve bu
histogramda bulunan kontrollerle (sürgüleri sağa sola hareket ettirerek) resmin parlaklığı
ayarlanır.

Resim 4.2: Levels iletişim penceresi
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Siyah noktanın (histogramın sol tarafında yer alan, doygun mutlak siyahı temsil eden
nokta) görüntünün en koyu düzeylerinin konsantrasyonuna ayarlanması ve öte yandan, beyaz
noktanın (histogramın sağ tarafında yer alan, doygun mutlak beyazı ifaden eden nokta)
görüntünün en açık düzeylerinin konsantrasyonuna ayarlanması, kalan düzeylerin daha
doğru biçimde yeniden atanmasını sağlar. Siyah noktayı ayarlamak için sol tarafta bulunan
sürgü, ara tonları ayarlamak için orta sürgü ve beyaz noktaları ayarlamak için sağ sürgü
hareket ettirilir.

Ayrıca bu ayarları yapmak için Levels iletişim kutusunda bulunan damlalık araçları
kullanılabilir. Sol taraftaki damlalık resmin en siyah noktasına, ortadaki ara tona veya
sağdaki damlalık en beyaz noktaya tıklandığında bu noktalara göre program düzeyleri
(resmin parlaklığını) ayarlar.

Resim 4.3: Orijinal Resim 4.4: Levels ile resmin parlaklığı ayarlandı.

4.1.2. Curves

Resmin parlaklığının ayarlanması için Levels yerine Curves iletişim kutusu da
kullanılabilir (Image / Adjusments / Curves - Ctrl+M veya Command+M). Aradaki fark, üç
farklı nokta (siyah, gri ve beyaz) yerine Curves ile tek bir noktanın ayarlanabilmesidir.

Curves iletişim kutusunda bir ızgara ve ızgaranın üzerinde bir grafik bulunur. Yatay
eksen görüntünün orijinal değerlerini, buna karşılık dikey eksen görüntünün yeni değerlerini
gösterir. İletişim kutusu yeni açıldığında, hiçbir yeni değer hesaplanmadığı için, grafik
çapraz bir çizgi hâlinde görünür. Yapılan değişiklikleri görebilmek için Preview işaretli
olmalıdır.

Resim 4.5: Curves iletişim penceresi
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Levels iletişim kutusunda olduğu gibi, Auto’ya tıklanabilir ve değerleri ayarlamak için
damlalık araçları kullanılabilir. Curves, Levels’a göre daha fazla kontrol imkânı sağlar.
Eğriyi yukarı doğru sürüklemek renkleri açar, aşağı doğru sürüklemek renkleri koyulaştırır.
Sadece ara tonları ayarlamak gerektiğinde, eğriye tıklayarak değişiklik yapılması
istenilmeyen noktalar işaretlenir ve daha sonra eğrinin orta kısmı sürüklenerek resmin
parlaklığı ayarlanır.

Resim 4.6: Orijinal Resim 4.7: Orijinal Curves ile ayarlandı

4.1.3. Brightness/Contrast

Görüntünün tonları (parlaklık ve kontraslık) buradan ayarlanır
(Image/Adjusments/Brightness/Contrast). Koyu, orta ve açık değerleri ayrı ayrı düzeltmek
yerine, tüm resme aynı düzeltmeyi uygular.

Her ne kadar Brightness/Contrast penceresi Levels veya Curves iletişim kutusunun
sunduğu imkânları sunmasa da oldukça kolay ve hızlıdır. Çoğu zaman ihtiyaç duyulan tek
şey budur.

Resim 4.8: Brightness/Contrast iletişim kutusu

Görüntülerin çoğunu biraz parlaklık ve kontrastını artırarak kurtarmak mümkündür.
Brightness/Contrast iletişim penceresinde sürgüleri sağa doğru kaydırmak parlaklık ve
kontrastı artırır. Sola doğru kaydırmak azaltır.
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Resim 4.9: Resmin sağ yarısı seçilerek parlaklık ve kontrastı artırıldı.

Image/Adjusments menüsünde yer alan Auto Contrast ancak bazı durumlarda işe
yarar. Bu komut görüntüdeki en açık ve en koyu pikselleri beyaz ve siyaha çevirir. Bunun
sonucunda aydınlık bölgeler daha açık, gölgeler ise daha koyu hâle gelir. Çok acelesi olan
işlerde kullanıcıların işine yarayabilir.

4.1.4. Color Balance

Renk dengesini anlamak için renk çemberini yakından incelemek gerekir. Renk
çemberinde her rengin karşıtı vardır. Herhangi bir renkten merkeze uzanan çizgiyi izlerseniz,
tam karşıtına ulaşırsınız. Cyan mavisi bu anlamda kırmızının karşıtıdır, yeşil magentanın
karşıtı ve sarı ise mavinin karşıtıdır.

Bir resimde renkleri ayarlamak için Color Balance (renk dengesi) iletişim kutusu
kullanıldığında, şiddeti azaltılmak istenilen renge karşıt renk eklenir.

Color Balance iletişim penceresi, belirli kısımlardaki renkleri düzeltmek için değil,
resmin tamamının genel renk düzeltmesi için kullanılmalıdır. Özellikle eski ve sararmış
fotoğraflarda işe yarar.

Resim 4.10: Color Balance İletişim Kutusu
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Color Balance iletişim kutusun açmak için Image>Adjusments>Color Balance seçilir
veya kısayol olarak Ctrl+B (Command+B) tuşları kullanılır. İletişim kutusunda bulunan
Shadows (gölgeler), Midtones (ara tonlar) ve Highlights (parlak bölgeler) seçeneklerinden
hangisinin seçili olduğuna dikkat etmek gerekir. Hangi bölgelere işlem yapmak isteniyorsa,
bunu buradan seçerek kontrol ediniz. Preserve Luminosity işaretlendiğinde resmin parlaklığı
da etkilenir. Sürgüler kaydırılarak renkler ayarlanır.

Resim 4.11: Orijinal Resim 4.12: Color Balance ile renkler ayarlandı.

4.1.5. Hue/Saturation

Renklerin ton ve doygunluğu buradan ayarlanır. Hue/Saturation penceresini açmak
için Image>Adjusments> Hue/Saturation menüsü veya kısayol olarak Ctrl+U (Command
+U) tuşları kullanılır.

İletişim penceresinde, üç ayrı sürgü bulunur: Hue, Saturation ve Lightness. Hue (tür)
sürgüsü, renk çemberi üzerinde hareket eder. Edit menüsünde Master seçili hâldeyken, Hue
sürgüsünü sürükleyerek renkler kırmızıdan mora, maviye ve mavimsi yeşile geçirilebilir.
Yani Hue sürgüsü ile rengin türü belirlenir.

Resim 4.13: Hue/Saturation iletişim kutusu

Saturation (doygunluk) sürgüsü ile rengin doygunluğu ayarlanır. % 0’dan en sağda
% 100 doygun hâle (saf renk, hiç grisiz) veya en solda % 100 doymamış (renk yok) hâle
getirilebilir.
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Lightness (açıklık) sürgüsü, ortadaki sıfır noktasından en sağda +100’e ve en solda -
100’e doğru resmin parlaklığını artırma ve azaltma mümkündür.

Açılır menüden Master’ı seçmek yerine belirli bir renk seçildiğinde, fazlaca bir
değişiklik olmaz. Bu durumda damlalık araçları aktif hâle gelir ve görüntünün belirli
renklerini seçme imkânı verir; ayarlama yapılabilecek aralığın sürgüleri, seçilen rengin
merkezindedir. Colorize seçili hâle getirildiğinde resmin tonları bu renge göre ayarlanır.

Resim 4.14:Orijinal Resim 4.15: Hue/Saturation ayarı yapıldı

4.1.6. Variations

Renkli bir görüntünün renk ayarlarını yaparken önceki ve sonraki hâllerini
karşılaştırmak gerekir. Resim işleme programında Image/Adjusments menüsünde bulunan
Variations ile bu yapılabilir. Çok sayıda renk ayarlama aracı Variations iletişim penceresinde
mevcuttur. Variations iletişim penceresi Image/Adjusments/Variations komutu ile açılır.
Pencerede aynı orijinal görüntünün farklı varyasyonları gözükür. Farklı ton ve parlaklık
varyasyonları seçilip orijinali ile karşılaştırılarak sonuç görülür (Değişiklik yapılan resim
Current Pick olarak isimlendirilir.).

Variations iletişim penceresi ilk açıldığında Current Pick orijinal görüntünün aynısıdır,
çünkü henüz hiçbir değişiklik yapılmamıştır. Sağ üst köşede bulunan sürgüyü sağa (Coarse)
veya sola (Fine) kaydırarak her bir değişikliğin görüntü üzerinde oluşturacağı fark gözükür.
En ince ayar Fine, değişiklikleri adeta gözlenemeyecek hâle getirir. Standart ayar ise (sürgü
ortada) normal ayarlamalar için en pratik olanıdır.
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Resim 4.16: Variations iletişim penceresi

Variations ile renkli bir görüntünün gölge (Shadow), ara ton (midtones), aydınlık
bölge (highlight) ve doygunluğu (saturations) ayrı ayrı ayarlanabilir.

Shadows, Midtones veya Highlights seçildiğinde resmin sadece bu parçasının ton ve
parlaklığının ayarı yapılır. Bunun avantajı, ara tonları bir yönde, parlak bölge ve gölgeleri
aksi yönde değiştirebilmektir. Her ayar birbirinden bağımsızdır.

Saturation’ın seçilmesi, görüntüdeki rengin şiddetini değiştirir, bu ayar rengin daha
güçlü veya zayıf olmasını sağlar.

Bu iletişim kutusunda bulunan Save (kaydet) ve Load (yükle) düğmeleri ile yapmış
olduğunuz ayarları kaydederek bir başka resimde de uygulayabilirsiniz. Bu özellikle birçok
resme aynı ayarlar yapılacağı zaman işe yarayabilir.
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UYGULAMA FAALİYETİ

Yukarıdaki resmin veya uygun bir resmin renk ayarlarını aşağıdaki işlem basamakları
ve öneriler doğrultusunda yapınız.

İşlem Basamakları Öneriler
 Resminizi inceleyerek yapılacak renk

ayarlarını belirleyiniz. Resmin
parlaklığını Levels iletişim kutusundan
ayarlayınız.

 Resminizi dikkatli inceleyerek iyi
tahlil ediniz.

 Levels iletişim kutusunu açmak için
Ctrl+L (Command+L) kısayolunu
kullanabilirsiniz.

 Resmin parlaklığını Curves iletişim
kutusundan da yapabilirsiniz. (Ctrl +
M; Command+M).

 Levels veya Curves iletişim
kutularıyla resmin parlaklığını
ayarlarken orijinalliği bozmamaya
dikkat ediniz.

 Resminizin kontrastlığını Brightness /
Contrast iletişim kutusu ile ayarlayınız.  Brightness/Contrast iletişim kutusuna

Image>Adjusments menüsünden
ulaşabilirsiniz.

 Fazla parlaklık ve kontrastlık
verildiğinde resmin orijinalliği
bozulacaktır. Buna dikkat ediniz.

UYGULAMA FAALİYETİ
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 Hue/Saturation iletişim penceresinden
resmin renklerinin türünü ve
doygunluğunu ayarlayınız.

 Hue/Saturation penceresine Ctrl
+U veya Comman +U kısayoluyla
ulaşabilirsiniz.

 Resmin sadece belli bir bölgesinin
rengini ayarlamak, diğer bölgeleri
olduğu gibi bırakmak için
değiştirmek istediğiniz bölgeyi
seçmelisiniz.

 Yandaki resimde sadece arabanın
kaportası seçilerek kaporta rengi
değiştirildi.

 Resmin renk dengesini Color Balance
iletişim kutusundan ayarlayınız.

 Color Balance (Renk Dengesi)
iletişim penceresine Ctrl +B
(Command+B) kısayoluyla
ulaşabilirsiniz.

 Bir rengin şiddetini azaltmak için o
rengin karşıtını artırmalısınız.

 Resmin gölge, aydınlık ve doygunluk
gibi ayarlarının tekrar yapılması
gerekiyorsa, Variations iletişim
penceresini kullanınız.

 Variations iletişim penceresine Image
/ Adjusments / Variations iletişim
penceresinden ulaşabilirsiniz.

 Variations penceresinde bulunan
Current Pick resmin yeni hâlini
gösterir.

 Renk dengesini ayarlarken
bozmamaya özen gösteriniz.
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ÖLÇME VE DEĞERLENDİRME
A. OBJEKTİF TESTLER
Çoktan Seçmeli Test

Aşağıdaki sorularda doğru olan şıkkı işaretleyiniz.

1. Aşağıdakilerden hangisi renk dengesini ayarlamak için kullanılan seçenektir?

A) Brightness/Contrast
B) Color Balance
C) Levels
D) Curves

2. Aşağıdakilerden hangisi resmin parlaklığını veya açıklığını ayarlamak için kullanılır?

A) Curves
B) Color Balance
C) Desaturate
D) Adjusments

3. Aşağıdakilerden hangisi resmin renk doygunluğunu ayarlamak için kullanılır?

A) Hue/Saturation
B) Brightness/Contrast
C) Levels
D) Curves

4. Aşağıdakilerden hangisi ile gölge, araton, aydınlık ve doygunluk ayrı ayrı
ayarlanabilir?

A) Color Balance
B) Levels
C) Variations
D) Curves

5. Resimde bir rengin şiddeti azaltılmak istendiğinde karşıt renk eklenir. Aşağıda renkler
karşıtlarıyla verilmiştir.

Buna göre aşağıdakilerden hangisi yanlıştır?

A) Cyan – Kırmızı
B) Yeşil-Sarı
C) Sarı-Mavi
D) Magenta-Yeşil

DEĞERLENDİRME
Cevaplarınızı modül sonundaki cevap anahtarı ile karşılaştırınız ve doğru cevap

sayınızı belirleyerek kendinizi değerlendiriniz.

Ölçme sorularındaki yanlış cevaplarınızı tekrar ederek, araştırarak ya da
öğretmeninizden yardım alarak tamamlayınız.

ÖLÇME VE DEĞERLENDİRME
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B. UYGULAMALI TEST

Öğrenme faaliyetinde kazandığınız becerileri aşağıdaki kontrol listesine göre
değerlendiriniz.

DEĞERLENDİRME ÖLÇÜTLERİ Evet Hayır

1. Resmin parlaklığını ayarladınız mı?

2. Resme kontrastlık verdiniz mi?

3. Resmin doygunluğunu ayarladınız mı?

4. Resmin renk dengesini ayarladınız mı?

5. Resmin; aydınlık, gölge ve ara tonlarına ayrı ayrı
işlem yaptınız mı?

DEĞERLENDİRME

Faaliyet değerlendirmeniz sonucunda “Hayır”ı işaretleyerek yapamadığınız işlemleri
tekrar ediniz.

Tüm işlemleri başarıyla tamamladıysanız bir sonraki faaliyete geçiniz.
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MODÜL DEĞERLENDİRME
UYGULAMALI TEST (YETERLİLİK ÖLÇME)

Opak bir orijinalin;

A) Tarama
B) Resim form ayarları
C) Rötuş
D) Renk ayarları

işlemlerini yaparak baskıya hazırlayınız.

Modülde kazandığınız becerileri aşağıdaki tablo doğrultusunda ölçünüz.

DEĞERLENDİRME ÖLÇÜTLERİ Evet Hayır

1. Resmi tarayıcıya yerleştirdiniz mi?

2. Tarayıcı iletişim penceresini açtınız mı?

3. Tarayacağınız orijinalin türünü bilgisayara girdiniz
mi?

4. Tarayacağınız alanı seçtiniz mi?

5. Tarama modunu belirlediniz mi?

6. Tarama çözünürlüğünü hesapladınız mı?

7. Orijinalin büyültme küçültme ayarını yaptınız mı?

8. Tarama işlemini tamamladınız mı?

9. Taranan resmi TİFF formatında kaydettiniz mi?

10. Resim işleme programında resmi açtınız mı?

11. Resmin ölçülerini ve çözünürlüğünü tespit ettiniz
mi?

12. Resmin çözünürlüğünü ayarladınız mı?

13. Resmin ölçülerini ayarladınız mı?

MODÜL DEĞERLENDİRME
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14. Resmi kırptınız mı?

15. Resminizin katmanı kilitli ise kilidini açtınız mı?

16. Resme perspektif verebildiniz mi?

17. Resmin renk modunu ayarladınız mı?

18. Resmi kaydettiniz mi?

19. Resim üzerinde bulunan pürüzleri, kırıkları resmin
orijinalliğini bozmadan yok ettiniz mi?

20. Resmin belli bir bölgesini flulaştırdınız mı?

21. Resmin belli bir bölgesini seçim araçlarını
kullanarak seçtiniz mi?

22. Seçim işlemlerinde Select menüsünü kullandınız
mı?

23. Resim üzerinde aydınlatma, karartma,
keskinleştirme ve renk yoğunluğunu artırma
işlemlerini yaptınız mı?

24. Resim üzerinde belli bir bölgeyi yeni bir katman
hâline getirdiniz mi?

25. Layers paletini kullandınız mı?

26. Resmin parlaklığını ayarladınız mı?

27. Resme kontrastlık verdiniz mi?

28. Resmin doygunluğunu ayarladınız mı?

29. Resmin renk dengesini ayarladınız mı?

30. Resmin; aydınlık, gölge ve ara tonlarına ayrı ayrı
işlem yaptınız mı?

DEĞERLENDİRME

Modül değerlendirmeniz sonucunda “Hayır”ı işaretlediğiniz işlemleri tekrar ediniz.
Tüm işlemleri başarıyla tamamladıysanız modülü başardınız.
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CEVAP ANAHTARLARI
ÖĞRENME FAALİYETİ-1 CEVAP ANAHTARI

1 C
2 B
3 C
4 D

5 A

6 B

7 C

8 B

9 D

10 D

ÖĞRENME FAALİYETİ-2 CEVAP ANAHTARI

1 B
2 B
3 D

4 A

5 A

6 D

7 C

8 D

9 D

10 B

CEVAP ANAHTARLARI
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ÖĞRENME FAALİYETİ-3 CEVAP ANAHTARI

1 C
2 B
3 B
4 B
5 A
6 A
7 B
8 C
9 D
10 A

ÖĞRENME FAALİYETİ-4 CEVAP ANAHTARI

1 B
2 A
3 A
4 C
5 B
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